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1. Introduction

NextFEM Designer is a user-friendly Finite Element Analysis program, which can be used alone or to be a pre- or postprocessor for several widely used FEM programs (i.e. OOFEM, SAP2000, Midas GEN, OpenSees, ABAQUS/CalculiX,
Zeus-NL, and others).
The most important features are:
-

general pre-processor capabilities: 3D and 2D views, customizable colours, accelerated rendering with
DirectX technology;
modelling with the most common structural elements, such as beams, shells and solid elements;
importing input files from DXF drawings, OpenSees scripts, Midas GEN, SAP2000, ABAQUS, OOFEM, ZeusNL;
importing results from SAP2000, OOFEM and OpenSees;
exporting models to SAP2000, ABAQUS, Midas GEN, OpenSees, OOFEM;
post-processing capabilities with deformed shapes with contour display, beam diagrams, stress and strain
contour.

1.1. Editions of NextFEM Designer
NextFEM Designer is available in the following editions:
-

standard version, that can be downloaded from nextfem.it, having all the features described in this manual;
Lite version, available only on Windows Store® for Windows 10® users. Such edition does not accept license
codes and the following features are not available:
o analysis on cloud;
o manuals for dedicated modules.
In this last edition, not all the features covered in this manual are present.

1.2. Installing NextFEM Designer
NextFEM designer is designed to work with Windows 7 SP1 or above and it is available for 32 or 64 bit Windows
versions. The prerequisites are:
-

.NET Framework 4.7.1;
DirectX v9.0c;
VC++ 2010 redistributable package
VC++ 2013 redistributable package

To manually associate the NXF files to NextFEM Designer, open it once as administrator (right click/Run as
)

1.3. License Activation
To activate the program you must be connected to the Internet at the first run. For the licensed installation, please
refer to the command
.
1.4. Manual and Support
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Along with NextFEM Designer is provided the user manual which describes the main controls and procedures to get
started with the program. Moreover, online support is available. It is possible to ask questions or give suggestions in
the dedicated part of the NextFEM forum (www.nextfem.it/it/nextfem-designer-support-forum/).
1.5. User interface
Display window looks like the figure below. It is possible to show the model (extruded or not), number of nodes or
element, loads applied, global axes and other properties of the opened file. On the bottom left corner, number of
nodes and elements of the model are shown.

NextFEM Designer user interface presents a menu bar on the top which contains all the commands that can be
used. Moreover, other toolbars, that can be anchored aside the viewport, which contain the major commands are
available. A toolbar can be added in the main window by clicking the button 3 of the mouse (see User Controls
chapter) and check it.

The following toolbars can be added:
-

File

-

Commands

-

Draw
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-

Results

-

View

The toolbars can be anchored to any edge of the viewport.

10

2. Modelling with NextFEM Designer

2.1. User controls
Mouse usage

-

1 Button one permits to select objects in viewport by:
o
o

-

Single object selection: clicking on nodes or elements;
Window selection: by pressing and holding down the button, elements can be selected.
Dragging the mouse from left to right only elements and nodes entirely contained in the
window are selected. Dragging the mouse from right to left every element or nodes that
intersect the window will be selected.
2 Button two (the mouse wheel) has a double function. Holding down it and moving the mouse, the
model moves; scrolling it, zoom changes.
3 Holding down the button three, the model rotates.

Keyboard shortcuts
-

Ctrl+X: Cut selected objects;
Ctrl+C: Copy selected objects;
Ctrl+V: Paste selected objects;
Ctrl+N: new model;
Ctrl+O: opens a model;
Ctrl+S: saves the model;
Ctrl+Z: undo operations in the model;
Ctrl+Y: redo operations in the model;
Esc: clears current selection;
Ctrl+A: selects the entire model;
Ctrl+D: deselects all nodes;
Ctrl+Q: opens Query dialog;
Ctrl+G: opens Verifications window;
Ctrl+W: integrates the selected section cut (only when results are displayed);
Canc: deletes selected nodes and elements;
F1:
11

- F2: shows selection only;
- Ctrl+F2: hides selection;
- F3: show view options;
- F4: shows the entire model;
- F5: show/hide nodes;
- F6: activate/disable extruded view;
- F7: shows node numbers;
- F8: shows element numbers;
- F9: shows nodal masses;
- F10: shows values in beam diagrams;
- F11: shows values in displayed loads;
- F12: shows constraints in the model.
For verifications:

-

Ctrl+1: Steel checking as per Eurocode 3
Ctrl+2: Steel checking for scaffolds as per EN 12811-1
Ctrl+3: Aluminium alloy checking as per Eurocode 9
Ctrl+4: Aluminium alloy checking for scaffolds as per EN 12811-1
Ctrl+5: Timber checking as per Eurocode 5
Ctrl+6: Concrete checking as per Eurocode 2
Ctrl+0: Opens Smart checking window.

Command line options
The following command line options are available:
-

-

-

(-i filename.ext)
allows to import a file specifying filename;
(-c nodes)
checks for free nodes in the loaded model;
(-c elems)
checks the counter-clockwise element connectivity in the loaded model;
(-e filename.ext)
allows to export the open model specifying filename, according to the specified
extension ext.
Available formats are:
o
o
o
o
o
o
o
o
o
: IFC4 file format for BIM.
(-d lc data item dir) : extract data from the result file loaded and save selected output in CSV format;
the following flags are currently supported:
o lc: Loadcase name;
o data
for reactions, displacements or beam
forces, respectively;
o item: number of node/element or "all" for the sum for all nodes/elements
default;
o dir: direction 1 2 3 4 5 6, according to global conventions (for nodes) or local ones (elements).
Optional.
(-r) : run the loaded/imported model
(-s [filename.ext] ) : save the loaded/imported model
12

-

(-p) : print the model report in PDF format
(-x) : closes the program after the batch operations as per any of the previous commands. T
does not need this because it exits anyway.

-

2.2. Local axis conventions
The following conventions are adopted for elements. Keep in mind that all the output forces/stresses/strains such as
beam diagrams or area stresses are plotted with the following conventions along the local element axes.

Beams
The second axis is always vertical and coincident with global Z.

Sections

Planar elements

Solid elements

13

Section cut

2.3. File menu
New:

Opens an empty model

Open:

Opens an existing model

Save:

Saves the model currently opened

Save as:

Saves the model in *.nxf or *.xml formats.

-

*.nxf is a proprietary file format;
*.xml saves the model in plain XML-formatted text.

Close:

Closes the model currently opened.

Import:

Imports model from other formats. See chapter 3 for supported formats.

Merge:

Imports model from other formats merging it with the one in use.

Import OpenSees results:

Imports OpenSees recorders

14

By the box Select results to be imported it is possible to import all the output files generated from the
procedure007.tcl routines, that are included in the program. All the file with extension .out must be in the same
folder of the already imported TCL model.
By the box Generic recorder
the recorder, select the proper checkbox. The recorder file must be in the same folder of the already imported TCL
model.
Import additional datasets:
Imports additional datasets defined by user. This command is particularly suitable
for importing data from external programs (i.e. OpenSees custom recorder). From the dropdown menu it is possible
to import:

-

User data: the format for such data is:
node (node numbers series, separated by spaces, tabs or semicolon)
time (series of data related to nodes, in the same order of the node numbers series in the first line)
or
element (element numbers series, separated by spaces, tabs or semicolon)
time (series of data related to nodes, in the same order of the element numbers series in the first line)
Such data will be imported in a new loadcase with the name of the source file, or with a temporary name if
data are pasted in the textbox. All data can be saved in the NXF file and will be displayed in Node data or
Element data results views.

-

Midas GEN results: it allows the import of results tables from Midas GEN® (command Results/Result tables
inside GEN). Tables can be pasted directly in the textbox. Supported tables are: Beam Forces, Wall Forces,
Node Displacements.
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Export:

Exports the model in many formats.

Exit: Closes the program.
2.4. Edit menu
Material:

To define materials properties:

16

-

To add a new predefined material, click on the Material library combo box to show the available
materials. Then select a material from the lower box and click on Pick to choose one of them;
To add a new customized material, click the Add user material button

The following quantities are required:
-

Name of the material
(optional) reference code
E
n
the shear modulus G (can be calculated automatically by clicking on Shear modulus from E and G)
the characteristic strength fk (for elastic material behaviour)
thermal expansion coefficient alphaT
weight density Wd
Mass density Md (can be calculated automatically by clicking on Mass density from weight density)

Click the Assign to selected elements to assign the selected material properties to the elements.
Click the button Cancel to exit this form.
With the command Shear modulus from E and n it is possible to get automatically the shear modulus G, computed
through the following equation:

G

E
2(1  )

With the command Mass density from weight density it is possible to obtain automatically the mass density by
dividing the weight density by the gravity acceleration, with is considered with consistent units.
The button Heat transfer settings permits to specify the laws of variation of density, conductivity and specific heat on
the base of temperature.
To add a new value in table for material checking, use the button Add once the textboxes Custom field and Value
have been compiled.
WARNING: it is strongly advised to insert units consistent with the initial choices (see Edit > Set units).
17

Sections:

-

to add Planar or Beam sections.

To add a planar section, specify the name and the thickness in the Planar section boxes and then press
Add planar section;
To add a beam section, click the Beam section drop-down menu and choose the type among
Rectangular, C-shape, Circular, Pipe, Box, By point options.

Click the Assign to selected elements button to assign the selected section to the selected elements.
The built-in beam sections available are:

Further section shapes are available: Omega and cold-formed non-thin-walled C shapes, that can be set
from inside the section properties.
Other custom libraries can be present in this list. For each of them, the following mask will be displayed to
allow selection. Several libraries for steel sections are included in the program.
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To see the properties (area and moments of inertia) of the inserted sections select a section and press the
Edit properties button. This mask allows also to import a section from DXF file and define a section by points
or by composing single figures.

WARNING: it is strongly advised to insert units consistent with the initial choices (see Edit > Set units).
In the Properties mask it is possible to specify the design properties of the section to be used during checking.

19

WARNING: by changing the sectional properties, the section
operation is not reversible.
Composite sections
The support for composite sections includes:

-

Beams with slab like in figure (a) and
Columns with coincident centres of gravity (b).

A composite section is automatically detected when:

-

Two or more filled figures, one of them associated to a steel material and one to a concrete material;
Properties of the composite section are defined inside the mask Section properties / Properties in order to
distinguish a beam or a column section.
WARNING: The effective width of the section Beff must be evaluate by the user as per current code of
practice.
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The stiffness of beam elements having such sections is evaluated as follows. With subscript s, steel properties are
described, while the ones related to concrete have the subscript c.
For beams, the moment of inertia for positive bending around the elastic neutral axis na is calculated as:

I zc Azc
2

 x  H tot  yc 
n
n
E
n  Azs  ys  Azc  yc
with n  s and x  H tot 
Ec
n  Azs  Azc
I z1  I zs  Azs   H tot  ys  x  
2

The moment of inertia of the section for negative bending around the plastic neutral axis is equal to the inertia
given by the steel section, as the concrete part is considered as cracked.
As a whole, bending stiffness is estimated as per EC4 and as a function of the factors Mpos and Mneg which can be

(a)

(b)

Hence, the resulting bending stiffness is:

I z  f Mpos  I z1  f Mneg  I zs
The remaining properties for the beam section are all calculated by dividing the concrete contribution by n.
For composite columns, once the factors Ec and R have been specified in the
inertial properties of the section are calculated as follows:

I

I z  R   I zs  zc
n

Es
with n 
f Ec Ec

I yc 
I yzc 



 ; I yz  R   I yzs 
;
 ; I y  R   I ys 
n 
n 




The remaining properties are all calculated by dividing the concrete contribution by n.
Strength calculator
By the Strength calculator button it is possible to define the rebar in a RC section and to evaluate its flexural
strength.
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In Define material properties the base material is specified.
The box Rebar position can be used to specify the rebar coordinates (eventually of rectangular shape by checking
the option Rect. rebar and by specifying the base dimension of the plate in Rect. base). The rebar coordinates are
input on the base of the section local coordinate system, by specifying the diameter and the associated material
The available materials should be customized by modifying or
adding *.nfm files in data/design subfolder in the software installation directory.
In order to insert strands for prestressed RC sections, it is possible to input the initial strand stress by activating the
Strand option and by inputting the stress in consistent dimensions.
To obtain the resistant values of the section, specify the Design forces in the required units. By selecting the Elastic
option, the response of the section is computed with elastic materials. By selecting Plastic, elastic-perfectly plastic
laws are used for material behaviour. In the Results box, the results of the performed computation are reported,
linked to the overlying graphs.
The window allows also resistant domains calculations reduced by thermal action. The software will compute the
strengths parameters of the section at the selected instant of time and thermal case, on the base of strengths
reductions laws for mechanical and resistant features of base material and rebar, if present.
The available options in this mask are:

-

Concrete non-linear behaviour allows to choose between parabola-rectangle and bilinear material
behaviour for the concrete material. If a simple rectangular or circular section are present, the Confined
concrete option is available in this menu, allowing to consider the confined part of the section inside
stirrups. In this case, data in Stirrups tab are required. Spirals are not supported.
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-

Allow concrete tensile strength can be enabled to activate the contribution of tensile strength of the base
material;

-

Bilinear hardening ratio allows to specify the ratio between the plastic branch of rebar and their elastic
modulus. In case of Steel or Aluminium base material, it specifies the hardening ratio to be used.

-

Steel class section sets the class of the section in case of Steel or Aluminium base material, i.e. if the section
can be calculated in plastic field or not.

-

Confidence Factor (C.F.) sets the confidence factor for strength of base material and rebar.

-

n factor specifies the value of the homogenization factor (modular ratio between steel and concrete). The
default is 15.

Stirrups tab helps to define the stirrups for the current section and to obtain a resisting strength for both direction of
the section.

Beam elements allows to retrieve the rebar defined for a beam to check its strength over the beam forces contained
in results, if available.

Load cases: Inserts the linear static load cases by writing the Name box and then clicking on the Add button.
Different load can be inserted without closing the Set load cases window.
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WARNING: only linear static load cases can be inputted from here.
Functions:

Adds Time History (TH) or Spectrum functions by points or file.

From the dropdown menu in Series tools you can set several types of TH functions, such as:
-

Eurocode 8 Spectrum: returns the design acceleration spectrum as defined in Eurocode 8 EN 1998-1-1
NTC2008 Spectrum: returns the design acceleration spectrum as defined in NTC2008 (Italian code of practice
D.M. 14-01-2008). The program uses an automatic geo-referencing algorithm that allows to search for
postal addresses finding the desired site.
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-

NTC2008 Wind Load: gives the wind action as per NTC2008 (Italian code of practice D.M. 14-01-2008) as a
function of building height
NTC2008 Snow Load: gives the snow load as per NTC2008 (Italian code of practice D.M. 14-01-2008) as a
function of height of the building site
Linear TH: returns a linear loading ramp
Sinusoidal TH: returns a sinusoidal function on the base of the properties chosen by the user
Calculated Spectrum: this option is enabled only if user has requested the acceleration spectrum of the
displayed acceleration TH through the button View spectrum
From File: allows the user to load a 2-columns text file containing a data series
Constant load: defines a constant loading plateau
EC8 Seismic Forces: allows to define a set of static lateral forces for each rigid diaphragm defined as per
EC8/NTC2008, to be used in an equivalent static analysis;
EC1 Wind Load: wind load as per Eurocode 1
EC1 Snow Load: snow load as per Eurocode 1
EC1 Standard Fire Curve: fire curve as per Eurocode 1. The resulting series has time in seconds.
EC1 External Fire Curve: external fire curve as per Eurocode 1. The resulting series has time in seconds.
EC1 Hydrocarbon Fire Curve: hydrocarbon fire curve as per Eurocode 1. The resulting series has time in
seconds.

Set units:
between:

Custom user units can be defined by clicking on the opposite drop-down menu and choosing
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-

-

-

Length:
o Metres [m] (default option);
o Centimetres [cm];
o Millimetres [mm];
o Kilometres [km];
o Inches [in];
o Feet [ft]
Force:
o Newton [N];
o DecaNewton [daN];
o KiloNewton [kN] (default option);
o KiloPounds-force [kipf]
Temperature:
o Celsius degrees [°C] (default option);
o Kelvin degrees [°K].

The following units are computed automatically in a consistent way:
-

-

Mass:
o
o
o
o
o
o
Stress:
o
o
o

Megagram [Mg];
Kilogram [kg] (default option);
Gram [g];
Ton [t];
Ounce [oz];
Pound [lb].
MegaPascal [MPa];
KiloPascal [kPa];
Pascal [Pa] (default option).

Check element connectivity:

Checks counter-clockwise connectivity for elements with more than two nodes.

Check element overlap:

Checks if there are some overlaid elements.

Check for free nodes: Check whether every node is connected to an element.
Check element properties:
Renumbering:

Checks if section and material have been assigned to each element.

Renumber the selected nodes and/or elements by the chosen criteria.
26

Check line mesh: Check all the line elements in the model to find out is there are disconnected beams (or trusses).
This command corrects the mesh by dividing the lines that present apparent intersections (i.e. a node belonging to
one element that lies on the joining line of the considered beam or truss).
Nodes tools
Merge overlapped nodes: Merges the nodes with the same coordinates in the whole model.
Move nodes: By selecting Move by increment, it moves the selected nodes of the specified quantity. By selecting
Move to absolute position, it moves the selected nodes in the chosen directions to the specified position.

Rotate nodes: Rotate the selected nodes with respect of a specified axis.
To define a custom axis select two nodes in the model.
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Scale nodes: Scale the selected nodes (and elements) with respect to a specified point in the 3D space.

Mirror nodes: Mirror the selected nodes (and elements) with respect to a specified plane in the 3D space defined
by 3 points.

Mesh tools
Mesh area: Automatically meshes an area into triangular elements. Choose the maximum area of the triangles
to be generated, select the nodes of the perimeter of the area to mesh and then click on the Acquire
28

selection button under the Filled areas section. To insert a hole in the mesh, select the nodes of the hole and
then press the Acquire selection button under the Holes section. To confirm press OK.

Mesh wall:

The command allows to insert and mesh walls of arbitrary dimensions, made of Quad elements.

To insert a wall insert the origin coordinates on the Origin box and specify its dimension on the Length and
Height box.
Enabling the Add upper cut/sloping option it is possible to insert sloping walls by specifying the Wall type
and the angle of inclination (with angle [°] box). Clicking on the Wall type drop down menu the following
options are available:
-

x;
y;
vertical that is in the working plane direction.

x and y can be used only if the working plane is set as XY, otherwise they have no effect.
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Through the Drawing controls pan it is possible to move in the working plane to insert quickly adjacent
panels.
Enabling the Add openings option, holes can be added in the wall.

Automesh wall:
The command allows to automatically mesh all the quad elements in the model, using
the size specified in the Options under Size for IfcWall mesh.

Mesh volume: this command allows to mesh solids into tetrahedral elements. In Maximum size box the maximum
characteristic size of the mesh element must be inserted; Minimum size sets the minimum characteristic size
and Mesh grading sets the percentage variation of characteristic dimension amongst elements in target
mesh. Press OK to mesh selected elements.

Divide and merge:
this command allows to divide in equal parts the selected line (2 nodes) and quad (4
nodes) elements. Moreover, it is possible to merge the selected line elements having the same first local
axis. Divide commands are available also for Quad and Hexa elements.
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Wall to frame: this command allows to obtain a frame from a shell wall model. This is particularly useful to
convert into beams all the Wall elements imported from a Midas GEN® model or to apply plastic hinges to the
beams obtained from walls. The local y axis of Quad element becomes the x axis of the beam.
Extrude section: this command extrudes the selected beam elements accordingly to their transversal section into
shell or solid models. This is particularly useful to convert a part of a frame into a shell or solid model to allow
detailing analyses, such as local buckling.
Change element type: This command allows changing the type of the selected elements. Pick a transformation
from the menu and then press OK.

The possible conversions are:
-

Truss->Beam: from truss to beam
Beam->Truss: from beam to truss
Beam->Beam3: from beam to 3 node beam (middle node)
Beam3->Beam: from 3 node beam to beam
Spring->Beam: from spring to 2 node beam
Beam->Spring: from 2 node beam to spring
Quad->Tria: from quad to tria
Quad->Quad8: from quad to quad8
(planar)->PlaneStress: from planar element to plane stress
(planar)->Shell: from planar element to shell
(planar)->PlaneStrain: from planar element to plane strain
Tetra->Tetra10: from tetra to 10 nodes tetra
Hexa->Hexa20: from hexa to 20 nodes hexa.
WARNING: PlaneStress and PlaneStrain elements can be used only in XY plane.

Extrude elements:
this command allows to extrude elements from selected nodes, tria or quad elements. In
all cases, the Extrusion direction and the Extrusion length must be provided by the user.

If Node to beam is checked, the selected nodes will be extruded to beam elements. Remember to assign a
material and a section to the obtained beams.
If Tria to wedge is selected, the selected tria elements will be extruded to wedge elements. By checking
Delete original elements, the initial tria elements will be deleted after extrusion. The material of newly
created elements will be assigned equal to material of original tria elements.
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If Quad to hexa is selected, the selected quad elements will be extruded to hexa elements. By checking
Delete original elements, the initial quad elements will be deleted after extrusion. The material of newly
created elements will be assigned equal to material of original quad elements.

Cut:

Cuts the selected elements (CTRL+X).

Copy:

Copies the selected elements (CTRL+C).

Paste:
To paste the copied/cut elements insert the shift coordinates in the opposite boxes and then click
in Paste button (CTRL+V).

Undo:

Undo the last action.

Redo:

Redo the previous action.

2.5. View menu
Select all:
Invert selection:

Select all nodes and elements in the model.
Select the complementary elements and nodes to those that have been already selected.

Clear selection:

Deselect all elements and nodes.

Delete selected:

Delete the elements that have already been selected.

Select group: This command allows to define group and to assign element and/or nodes to it. It permits also to
select nodes and elements previously assigned to a group.
To define a group, write its name in the Name box and press the Add button. To assign elements and nodes
to each group select the group in the Active groups pan, select the nodes and the element to assign to the
group and then click the Add selected nodes or Add selected elements button.
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To select nodes or elements previously assigned to a group activate the desired group in the Active groups
panel and then press the Select nodes in group/Select elements in group button
Select by name: This command allows to select nodes and/or elements by name (ID). The names must be written
separated by a space.

Select by property:
-

By this option, elements can be selected by section, by material or by their type.

To select all the elements with the same section activate it in the Elements by section pan and the click
the Select button. Press Unselect to deselect, Hide to hide them and Show to add them to the view.
To select all the element with the same material activate it in the Elements by material panel and then
press the Select button.
To select all the elements of the same type such as Node, Line, Triangle, Quad, and so on, select the
type(s) in the Elements by section pan and the click the Select button.

Show all:

Shows all the elements and nodes in the model

Show selection only:

Limits the view only to selected elements

Hide selection:

Hides selected elements
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Box pan/rotate:
PCs.
Move:

Move the model (pan command).

Rectangle Zoom:
Views:

Rotates the model avoiding the graphic regeneration of each element. To be used in old

zooms the area selected by a selection rectangle

Changes the view options. Choose between:
3D: Shows the entire model in a 3D view;
XY: Shows the model from the front in the XY plane;
XZ: Shows the model from the front in the XZ plane;
YZ: Shows the model from the top in the YZ plane;

View nodes:
Extrude:

Enable/Disable viewing of nodes in the model
Enable/Disable viewing of extrude model

Display loads:
shows loads applied to the structure depending on their type. To show a load type, click
on the drop-down menu and choose between point, line, area or volume.

Then select the wanted load case form the bottom toolbar.

View controls:

Through this panel it is possible to change the parameters of the view.
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-

Partition opening: experimental function that enables loading ADAPTIC partitions;
View Settings shows the point of view and other graphics options of the model;
Nodes number shows the number of the nodes in the model;
Nodes masses displays the positions of nodal masses in the model;
Element number shows the number of the elements in the model;
Values on diagrams shows values in the beams force diagrams;
Values on loads displays the values of applied loadings;
Constraints displays the applied constraints in the model;
Restraints displays the applied restraints in the model (active by default);
Hinges in beams displays the hinges applied to the beam elements (active by default);
Display in decimal format shows all number in viewport (both for loads and results) in the desired
format (e.g. 0.000 .

In the box called Values on diagrams it is possible to specify which values have to be reported in the viewport when
Values on results is activated. This allows to enable/disable values for each one of the 5 output stations in a beam
diagram.
Model data: This tool allows to see the Nodes, Elements or Loads in the model as long as theirs coordinates.
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From this mask it is also possible to modify loads and restraints simply by changing the values in the showed table
and then clicking on Store changes.

Model tree:

Shows the main properties of the model (materials, sections and loads currently applied).
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Set contour limits:
It allows to set the limits in the current displayed contour plot. This mask contains also
commands to plot the isocurve of a certain values for some selected shell results (stresses, forces,
temperature).

WARNING: The contour limits affects the colours associated to the extreme values of contour. Any value
exceeding the limits will be associated with the colour of the nearest extreme limit (red or blue).

2.6. Draw menu
Node:

Inserts nodes in the model, after a working plane is selected.

Node by coordinates: Inserts nodes by coordinates. To insert a nodes by coordinates, insert them on the
textboxes and then click on the Add button. It is possible to insert nodes until the Close button is pressed.

Truss:

Inserts truss elements between two nodes. This element can react only in tension or compression.

Beam:
Inserts beam elements between two nodes. To insert a beam element select a section and a
material from , if it has already been defined, from Selected section drop-down menu in the Section selection
window and then click on the nodes to be connected. Once finished click on the Close button in the
Selected nodes window.
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Beam3:

Inserts a 3 nodes beam elements. The three nodes must be aligned.

Triangle:

Creates a 3 nodes triangular plane element.

Triangle6:

Creates a 6 nodes triangular plane element.

WARNING: Triangle6 elements are transformed in a group of 3 nodes elements with the default solver.
Quad:

Creates a four nodes quadrilateral plane element.

Quad8:

Creates an eight nodes quadrilateral plane element.

WARNING: Triangle6 elements are transformed in a group of 3 nodes elements with the default solver.
Tetra:

Creates a 4 nodes tetrahedron.

Tetra10:

Creates a 10 nodes second-order tetrahedron.

Wedge:

Creates a 6 nodes wedge.

Hexa: Create an 8 nodes hexahedral element.
Hexa16:

Create a 16 nodes hexahedral element.

Hexa20:

Create a 20 nodes hexahedral element.

Spring:

Creates a 2 nodes spring.

WARNING: To create a spring element, the spring properties must be specified in Assign/Spring properties
and then assigned to the element.

2.7. Assign menu
Loads
Automatic loading: Allows to assign to all the elements in the model some automatic-generated loads, such as
self-weight and wind loads.
The command Assign self-weight loads produces the distributed load only for the elements having a material and a
section assigned to.
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The command Assign in the Wind loads box produces the assignation of wind load to all the Line elements in the
model, in the chosen direction. The loading is calculated from a defined user function, and applied to the lateral
surface of each element, obtained from the largest edge of the transversal section.

Point load: Applies a concentrated loads to selected nodes. To insert a concentrate load:
-

Select one or more nodes;
Insert the loads value in the Load value box;
Select the direction clicking in a radio-button on the Direction box;
Select the load case on the Load case drop-down list;
Click on the Apply button to set the load.

To use a value from a defined function, pick the desired function from the Pick function menu and then
specify the value from which read the function the in the At X menu. Optionally, a multiplier for the
resulting value can be specified.
Finally, the option Temperature allows to assign a nodal temperature to be used in Heat-transfer load cases.

Distributed load:
-

To insert a distributed load on a line element:

Insert the value of the load in Uniform load value box specifying the correct sign in global coordinate
system;
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-

Select the Direction of the load;
Select the proper Load case;
Select the element in the model and click on the Apply button.

To remove a distributed in the selected load case, select the element in the model and click on the Remove
button.
By the Non-uniform loading box it is possible to insert linear distributed load by points, specifying the
proper distance for the input values.

WARNING: The units need to be consistent with the initial choices [Force/Length].
WARNING: Since version 1.3, non-uniform loading is supported even in the default solver. An indefinite
number of multi-linear distributed loads can be applied on the same beam.
WARNING: Rigid offsets applied on beams having non-uniform loads must be placed before and/or after the
beginning or the end of the loads, otherwise they will not be considered.
WARNING: Line3 elements, for compatibility reasons, do not support non-uniform loading. Line elements
can be used without losing accuracy.
Temperature: Applies a thermal load, which causes a structural deformation, to the selected beams and planar
elements. Beam element support the uniform gradient and the linear temperature gradient, in both y and z
directions of the transversal cross section. Planar elements support only uniform gradient. Finally, solid elements do
not support thermal loading.
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Edge load: Applies an uniform load on an edge of an element. It can be used to assign forces per unit of length
(Force option) or temperatures (Temperature option). This last option is intended to be used of heat transfer analysis
only. After you selected the planar element, from the Select side box it is possible to highlight the chosen edges.
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Non-uniform loading box allows to set a final value for load. The button Apply on path by selected nodes allows to
apply edge loads following selected nodes.
Floor load: Applies a floor load on a triangular surface defined by Line elements or quadrangular by selecting 3 or
4 nodes. Choose the floor type within:

-

Centroid-trilateral plane: to load a triangular plane distributing the load all over its sides;

-

Centroid-quadrilateral plane: to load a quadrilateral plane distributing the load all over its sides;

-

One-way quadrilateral plane: to load a quadrilateral plane on 2 or more sides taking into account the load
direction (i.e. floor frames);

-

Two-way quadrilateral plane: to load quadrilateral plane with 2-way distribution (tributary area method).

In the Set floor load mask target load cases and relatives values can be specified.
In the Load direction box it is possibile to specify a direction for applied loads. The default setting Normal to plane
applies the loading normal to the plane by considering its clockwise or counterclockwise orientation. This setting
will be ignored if another direction is specified.
To draw the plane once selected the desired plane load, select Draw plane.
WARNING: input loads in this section must have F/L2 dimension.
WARNING: edge plane elements can only be of Line type.
WARNING: the plane drawing direction defines the load sign (positive or negative) in the global coordinate
system - draw planes counter clockwise to keep the value defined in the Set load table.
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Pressure load:

Applies a pressure load on planar elements.

The Non-uniform loading box allows to apply a bilinear load on a face of planar element.

Volume load:

It applies a load per unit of volume on solid elements.

Point displacement:

Applies displacements to selected nodes.
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Initial temperature:

Set the initial temperature in the model.

WARNING: This command affects only thermal analyses. It does not affect the loads induced by thermic
distortion.
Pretension load:
Applies pretension loads to linear (truss and beams) elements. A positive value signifies a
tensioned element (i.e. tendons, cables). Only positive values are permitted (i.e. element in tension).

WARNING: The load is displayed as a uniform thermal distortion on the element. The value of distortion will
have the opposite sign of the assigned pretension.
Point Mass:

Applies masses to selected nodes.

WARNING: The units need to be consistent with the initial choices.
WARNING: You may want to add the nodal mass in all the three translational directions.
Masses from loads: Allows to transform, automatically or once at a time, the loads contained in a load case into
masses.
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Material:
Section:

Assigns material to the selected elements.
Assigns section to the selected elements.

Local axes rotation: In the Beams box, the command rotates the selected beam sections by the counterclockwise angle specified.
In the Planar Elements box, it rotates the planar local axes by changing the element connectivity.

Restraints:

Assigns restraint to the degrees of freedom selected by checking the appropriate check box.

In viewport, the following drawing conventions applies:
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-

x, y and z checked (simple support)

-

all checked (fixed end)

-

x, y, z and ry, rz blocked (fixed in XZ plane, simply supported in YZ plane)

-

y and z fixed, slider in plane xz

-

x, y, z and rx blocked

-

only ry blocked

-

rx and ry blocked

-

all other restraint types.

Constraints:
Assign a constraint (i.e. rigid diaphragm or master-slave link) to selected nodes. By the
Rigid diaphragm preset, a rigid floor can be applied to the selected nodes.
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WARNING: The master node must be bounded properly to avoid singularities in the model. This
procedure always proposes the proper boundary conditions automatically.

Groups:

Assign groups to selected elements

End releases: Assigns end releases to beam elements. By specifying a value between 0 (fully released) and 1 (fully
fixed) in the textbox next to the check, a partial end release to be used in a linear elastic analysis can be obtained.
The reduction factor r is applied to reduce the stiffness of the beam by the ratio r/(1-r).
Input stiffnesses allows to directly set stiffness values instead of force ratios.
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Rigid offset:

Assigns one or more rigid offsets to beam elements.

WARNING: Loads on a beam with rigid offsets are not modified not changed or adapted to the rigid
segments. As a result, distributed loads on beams can decrease in their overall intensity due to the lesser length of
application.
Element properties:

Assigns custom properties to beam elements. For the property names and reserved values
see chapter 4.
from the box Beam section offset.
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Hinges:

Assigns plastic hinges to beam elements. After the name of the hinge has been inserted, press Add. At
this point, each DoF of the hinge can be set by inserting the properties listed below. Press Modify to
save the hinge properties.
The Hinges options box allows to specify under which loading conditions all hinges have to be
recalculated. This is particularly useful for hinges with NVM interaction.

Data requested for a Bilinear Symmetric plastic hinge are:
-

Fy: strength at elastic limit;
cKpl: coefficient to set the slope of the plastic branch Kpl=cKpl * Kel;
: hinge ductility;
Fres/Fy: residual strength in percentage of Fy.
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Data requested for a Bilinear Unsymmetrical plastic hinge are:
-

Fy+: strength at elastic limit;
cKpl+: coefficient to set the slope of the plastic branch Kpl=cKpl * Kel;
: hinge ductility;
Fres/Fy+: residual strength in percentage of Fy+
to define the negative part of the hinge law.

The hinges inserted with Custom properties are defined by setting all the above data.
By selecting NVM from the DoF dropdown menu it is possible to assign an axial/shear/flexure interacting hinge. The
calculation of all its properties is made automatically on the assignation on the base of checking type selected from
the dropdown menu Hinge type. NVM hinges always have an unsymmetrical bilinear law.
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Member:

Assigns one or more elements to a member. This affects the verification of a beam element.

Rebars:
Assigns reinforced bars to beam elements. By selecting the desired section from the Beam sections
box, the potential rebar defined in Assign/Sections/Strength is shown and it can be applied to the beams having that
section.
The table in the box named Assigned rebar shows the longitudinal and shear reinforcements assigned to each beam,
or to a portion of a beam by specifying the Start at and Ends at values.
The Rebar position box allows to define and change longitudinal and shear reinforcements. Stirrups are defined in
the Shear reinforcement sub-box. The Fast rebar positioning box allows to easily insert simple rebar schemes for the
most common sections.
Span drawing shows the longitudinal section of the beam, highlighting the selected part.
WARNING: units of measure used in this mask are the same defined for the model, except for the diameters of
the available bars in the dropdown menus, with are shown in mm.
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Spring properties:
Add, modify or assign one set of properties (elastic stiffnesses) for linear springs.
It is also possible to specify and assign subsoil distributed springs on beam elements (as elastic foundations) by
using the box Elastic soil properties in Z direction by using the button Add soil spring after having set the
modulus and the Beam width.

The Assign as nodal spring to selected nodes button allows to assign to a node the selected spring, connected to
another fully fixed node that is automatically restrained.
It is possible to assign non-linear properties for a translational (x, y, z) or rotational (rx, ry, rz) DoFs, either in global or
local coordinates as specified in the upper right corner of the property box. By clicking on the NL checkbox, the non52

linear properties dropdown will list all the hysteretic laws available. Select one item from the dropdown to set
properties.
WARNING: in order to define the non-linear properties, it is necessary to add a spring property first. Once the
non-linear properties have been defined, click on Modify property to store them.
The non-linear models available in NextFEM Designer are:
-

Gap: gap spring is particularly useful for representing contact (i.e. gap with null opening). Such model
works only in compression with the stiffness defined by the user.
Data requested for Gap are:



closure: maximum closure of the gap;
Kclosure: slope of the compression branch.

-

Hook: this law reacts only in tension. Data requested for Hook are:
 opening: displacement at which tension stiffness is not null;
 Kopening: slope of the tension branch.

-

Bilinear Plastic: the elastic behaviour is maintained until the yielding force Fy is reached, then the plastic
field begins. Once the ultimate displacement Uu is achieved, the spring breaks, maintaining a residual force
Fres. This law has a symmetrical behaviour.

53

Data requested for a Bilinear Plastic behaviour are:





-

Kel: elastic stiffness assigned to the spring;
Fy: strength at elastic limit;
cKpl: coefficient to set the slope of the plastic branch Kpl=cKpl * Kel;
Uu: ultimate displacement;
Fres: residual strength after collapse.

Bilinear Unsymmetrical: this behaviour is suitable for modelling non-symmetric behaviour in structural
elements. This law has an unsymmetrical behaviour.

Data requested for a Bilinear Unsymmetrical type behaviour are:





Kel+: elastic stiffness assigned to the spring;
Fy+: strength at elastic limit;
cKpl+: slope of the positive plastic branch;
Uu+: ultimate displacement allowed;
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-

Fres+: residual force for
All the above quantities f

- are the same properties for the compression side.

Trilinear Plastic: after reaching the plastic field, the skeleton curve is characterized by an hardening branch
bringing to Fmax, followed by a hardening/softening one that leads to failure at Uu. This law may have or
not a symmetrical behaviour.

Data requested for a Trilinear Plastic behaviour are:

-

 Kel+: elastic stiffness assigned to the spring;
 Fy+: strength at elastic limit;
 Kp1+: slope of the first plastic branch;
 Fmax: maximum strength reachable;
 Kp2+: slope of the second plastic branch;
 Uu+: ultimate displacement in positive direction;
 All the above quantities (except Fmax)
- are the ones for the compression side;
 Fmin: maximum strength reachable in compression.
Pivot rule: such model follows the rules defined in Dowell RK, Frieder S, Wilson LE. Pivot hysteresis model for
reinforced concrete members. Struct J 1998;95(5):607 17. The law can be set as not symmetrical. The
definitions of the pivot points can be made by setting the and parameters.
Referring to the Trilinear Plastic rule, the additional parameters are:
 alpha1: sets the pivot point for unloading from a tensile force to zero;
 beta1: sets the pivot point for reverse loading from zero to a negative force. Must be set between 0
and 1;
 alpha2: sets the pivot point for unloading from a compressive force to zero;
 beta2: sets the pivot point for reverse loading from zero to a positive force. Must be set between 0
and 1.
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-

Tomazevic-Lutman model: represents a trilinear behaviour as defined in Tomazevic M, Lutman M. Seismic
behavior of masonry walls modeling of hysteretic rules. J Struct Eng 1996:1048 54. It is influenced by
parameters alpha and beta, which determine the stiffness and the strength degradations, respectively. This
model is suitable for shear DoFs in masonry walls. This law has a symmetrical behaviour.

Data requested for Tomazevic-Lutman model are:










-

Kel: elastic stiffness assigned to the spring;
Fy: strength at elastic (cracking) limit;
Kpl1: slope of the first plastic branch;
Fmax: maximum strength reachable;
Kpl2: slope of the second hardening/softening plastic branch;
cF: coefficient to set unloading force ratio from the backbone;
alpha: coefficient for linear stiffness degradation at unloading (Kult=alpha*Kel);
beta: coefficient for strength degradation on the base of energy dissipated in a cycle (default 0.06);
Uu: ultimate displacement.

Ring-shape: this model represent a poor dissipative cyclic behaviour and can be used, for example, for
flexural DoFs in slender masonry panels. The backbone can be bilinear if Kpl2 is set to zero.
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This law has a symmetrical behaviour.

Data requested for the Ring-shape model are:











-

Kel: elastic stiffness assigned to the spring;
Fy: strength at elastic (cracking) limit;
Kpl1: slope of the first plastic branch;
Fmax: maximum strength reachable;
cC: coefficient to set the slope of the unloading path;
cF: coefficient to set unloading force ratio from the backbone;
alpha: coefficient for linear stiffness degradation at unloading (Kult=alpha*Kel);
cD: way point for the unloading path - distance from elastic limit in backbone curve;
Uu: ultimate displacement;
Kpl2: slope of the seconnd plastic branch, can be set to 0 to remove it.

Slip type: trilinear behaviour exploitable for shear connection in timber structures (nails, screws, angle
brackets, ect.). Such law is based on the work Rinaldin G., Fragiacomo M. A Component Model for Cyclic
Behaviour of Wooden Structures. Materials and joints in Timber structures: recent developments of technology,
RILEM Bookseries, Vol. 9, pp. 519-530, 2014, DOI: 10.1007/978-94-007-7811-5_48, ISBN: 978-94-007-7811-5.
This law has a symmetrical behaviour.
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Data requested for the Slip-type model are:














-

Kel: elastic stiffness assigned to the spring;
Fy: strength at elastic limit;
Kpl1: slope of the positive plastic branch
;
Fmax: maximum strength reachable;
Kpl2: slope of the negative plastic branch,
;
cKunload: it sets the unloading stiffness of the first branch of unloading (green) and of reloading
(blue) path by multiplying the elastic stiffness by this factor;
cFreload: it sets the lower limit of last branch of reloading (blue) and unloading (green) path, in
percentage of the force value in the backbone. Such parameter must be set between 0 and 1;
cFunload: it sets the lower limit of first branch of unloading (green) and reloading (blue) path, in
percentage of the force value in the backbone. Such parameter must be set between 0 and 1;
Uu: ultimate displacement;
alpha: exponential strength degradation parameter based on dissipated energy;
beta: exponential strength degradation parameter based on maximum displacement reached;
gamma: linear strength degradation parameter;
cKreload: sets the unloading stiffness of last branch of the reloading (blue) and unloading (green)
path by multiplying the elastic stiffness by this factor.

Unsymmetrical Slip-type: this behaviour is suitable for modelling hold-down connections in timber
structures. Such law is based on the work Rinaldin G., Fragiacomo M. A Component Model for Cyclic Behaviour
of Wooden Structures. Materials and joints in Timber structures: recent developments of technology, RILEM
Bookseries, Vol. 9, pp. 519-530, 2014, DOI: 10.1007/978-94-007-7811-5_48, ISBN: 978-94-007-7811-5.
This law has an unsymmetrical behaviour.

Data requested for an Unsymmetrical Slip-type behaviour are:






Kel: elastic stiffness assigned to the spring;
Fy: strength at elastic limit;
Kpl1: slope of the positive plastic branch, must be
Fmax: maximum strength reachable;
Kpl2: slope of the negative plastic branch
58

;
;














-

cKunload: it sets the unloading stiffness of the first branch of unloading (green) and of reloading
(blue) path by multiplying the elastic stiffness by this factor;
cFreload: it sets the lower limit of last branch of reloading (blue) and unloading (green) path, in
percentage of the force value in the backbone. Such parameter must be set between 0 and 1;
cFunload: it sets the lower limit of first branch of unloading (green) and reloading (blue) path, in
percentage of the force value in the backbone. Such parameter must be set between 0 and 1;
Uu: ultimate displacement allowed;
Fmin: maximum strength reachable in compression;
Kneg: stiffness coefficient for compression branch, multiplies the elastic stiffness;
cFend: coefficient for setting the force value at the end of the last branch of the unloading path
(green), multiplies the yielding force;
cFinit: coefficient for setting the force value at the beginning of the first branch of the reloading
path (blue), multiplies the yielding force;
alpha: exponential strength degradation parameter based on dissipated energy;
beta: exponential strength degradation parameter based on maximum displacement reached;
gamma: linear strength degradation parameter;
cKreload: sets the unloading stiffness of last branch of the reloading (blue) and unloading (green)
path by multiplying the elastic stiffness by this factor.

Dashpot: represents a non-linear dashpot element accordingly to Kelv
dynamic analysis, and gives a response defined as:

F  C  u  K  u  F0
where the stiffness is

K

1
1
1

Kr K0

The needed parameters are:
 Kr: restoring stiffness of the dashpot;
 C: damping of the dashpot;
  damping exponent;
 K0: initial stiffness of the dashpot;
 F0: preloading force. Below this value, damper is not active.

Generate combinations
This command allows to the safety factors and the partial coefficients for the automatic generation of load
combinations as per Eurocode.
The Self-weight override option permits to apply a different coefficient to self-weight loadcase, as requested by some
codes (e.g. Italian regulations).
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The calculated combinations can be edited from the Analysis settings command.

Analysis settings:
Defines the type and the sequence of the analyses. The combinations can be defined
adding linear load cases to a defined case. To add an analysis, select an Analysis mode, an Analysis type and, if
needed, a Combination type. Then click on Add.
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The program allows the following types of linear and non-linear analysis:
-

Static
Dynamic
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-

Response spectrum analysis (user must check Dynamic first, and the option Response spectrum. Hence, a
design spectrum can be selected from the TH load or spectrum box)
Modal, to find structural periods and eigen-vectors of a model;
Buckle, to find the buckling modes of a model;
Heat transfer, to analyze models in XY plane and to get thermal maps (for example from a section);
P-Delta, for static analysis including second-order geometrical effects. Such kind of analysis are carried-out
iteratively, but in only one loading step, and results can be used in combinations. To include second order
nd
geometrical effects in multi-steps non-linear analyses, fl

In the Combination mode box, user can choose the type of combination to be performed:
-

Base for all the linear static load cases
Sum for the load combinations in which the cases specified in the Linear loadcases box have to be summed;
Envelope for the load combinations in which the cases (or combinations) specified in the Linear loadcases
box have to be enveloped;
SRSS to perform a Square Root of the Sum of Squares of the cases (or combinations) specified in the Linear
loadcases box.

From the Type drop-down menu in the Analysis sequence and combination box, the type of each loadcase or
combination can be chosen, for using in checking. If this has not been specified, checking could not be run for the
specific combination.
With the command Export combos in CSV file, a CSV file containing all the combinations and their combination
coefficient can be obtained in a tabular format.
onse
Spectrum analysis damping ratio of the spectrum employed is required.
Finally, for applying a displacement history (as defined by imposing displacement) in non-linear analyses, set Factor
to 0.
2.8. Tools menu
Run: This option allows to run all the analyses.
Run selected: This option allows to run the selected analyses. To exit without running anything, set all to No and
press OK.

Login to cloud:
This option allows to run analyses on the NextFEM cloud by connecting to the NextFEM
server using the use
Username and your Password obtained
from the registration on the NextFEM Internet site.
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Once connected to the cloud it is possible to launch analyses by selecting them from the Select case to run
list and then click on the Submit button.

Once the analysis has been submitted, it will be completed in the cloud. When the analysis is completed it
is possible to view the result at any time clicking on the Retrieve results button.

Query:
Provides information about the selected element/node. By picking 2 nodes, it is possible to
measure the distance between them.
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Screenshot:

Copies to the clipboard the current viewport

Model wizard: it allows the guided setting of a new model through the definition of materials, sections, load cases
and masses.
Frame generator:
-

This command generates automatically a regular spatial frame. The input data are:

The number of bays along X and Y, the number of story and their span;
The material and the transversal section to be assigned to the beams and columns
OPTIONAL: the loads to be assigned to beams by choosing the roof framework direction. Target load cases
must already be defined to proceed;
OPTIONAL: you can apply automatic floor diaphragms.

Section from model:

It allows to create a section from a thermal model in XY plane.
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Plugins:
This menu section lists all the plugins loaded at startup. Plugins are in English language only, and
they are completely independent from Designer. For further information: www.nextfem.it/dev/
Some plugins are included by default in NextFEM Designer, such as:
Floor modeller, to transform a loading plane to a shell plane loaded on surface;
Custom report compiler, to edit a DocX document by including data and images from model;
Parametric solver to carry-out parametric analyses in an easy way.
Options:

It allows to change the visualization options as long as the solver options.

To change from the default solver (OOFEM) to OpenSees the user must enter the Path to OpenSees.exe box.;
to use the solver CalculiX the user must enter the Path to ccx.exe.

WARNING: OpenSees and CalculiX solvers are not fully supported, and not distributed by NextFEM.
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The option Save results in NXF files allows to save the results of a model in the NXF file, only if the
calculations are performed with OOFEM.
The option Autosave model every n minutes allows to automatically save the model every n minutes as
specified by the user.
The option Include curvature and strain in shell results allows to get curvatures and strains in results for shell
elements. Enabling this option may slow down the analysis and increase the model weight.
The option Solver allows the user to choose the default solver:
- Standard: it
- DSS solver: Direct Sparse Solver, optimized for fast solving of large problems. Labilities will not be
detected;
- SPOOLES solver: SParse Object Oriented Linear Equations Solver, optimized for fast solving of large
problems. Labilities will not be detected.
Path for temporary files shows the temporary folder used by the solver.
OOFEM Preferences
The option Include shear deformation in beam elements activates the Timoshenko contributions for beams in
the default solver.
The option Reduced integration for 4-node shells activates the reduced integration for 4-node quad elements
in the default solver.
ADAPTIC Preferences
The option Read nodal velocities and accelerations from NUM files enables the reading of velocities and
accelerations in results import from ADAPTIC NUM file.
BIM Preferences
The option Size for IfcWall mesh allows to specify the mesh size to be used during import of IfcWall elements
from IFC or IFCxml files.
General preferences
It allows to set the tolerance for merging nodes and to set the separator for CSV export.
2.9. Results menu
Display results:
It shows the result of the analysis by load. To show the appropriate Result type, LoadCase;
DataSet and Component, select them from the respective drop-down lists.

Available results can vary on the base of the performed analysis, and can be:
-

Frame forces to show beam diagrams
Frame stresses to show a contour of beam generalized stresses
Frame strains to show a contour of beam deformations
Frame Displacements to show a contour of beam deflections
Frame subsoil reactions to show a contour of the soil reactions for beams with subsoil springs
Node Displacements to show the deformed shape and a contour of nodal displacements
Node Velocities to show the deformed shape and a contour of nodal velocities
Node Accelerations to show the deformed shape and a contour of nodal accelerations
Node Reactions to show the nodal reactions in restrained nodes as arrows
Area Forces to show forces per unit of length in planar elements
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-

Area Stresses to show stresses in planar elements
Area Strains to show deformations in planar elements
Solid Forces to show solid elements forces
Solid Stresses to show solid elements stresses
Solid Strains to show solid elements deformations
Node data to show node-related data such as checking ratios or custom values
Element data to show element-related data such as checking ratios or custom values
Area temperature to show the thermal map of planar elements
Solid temperature to show the thermal map of solid elements (not yet available).

Extract data: Extracts results data in tabular format.
To extract the result follow the following procedure:
-

Select a load/step by clicking on it in the Select load case or step list;
Select a time or mode by clicking on it in the Select time or mode list;
Select a data type, so that a result type from the Select data type list;
Select the number of the node or element in the Number list.
Optionally, choose the number of stations/points in the Stations/points window.

To export the shown data in a tabular format, press Export as CSV button. The command Export all as CSV allows to
export all the data of the selected type (in the Select data type box) for all elements or nodes.
The Operation on values box allows to apply simple orations (sum, sum of absolute values, absolute values) on the
requested (multiple) data.
The Filter by box allows to display only data associated to selected materials, sections, etc.

Verifications: It allows to handle and checks some defined quantities on nodes/elements.
To checks the nodes/elements the following procedure has to be done:
-

choose a quantity to check from the quantities drop-down list;
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-

Choose a load case and a time/mode (or select ALL for all times/modes);
Import the formulas from a customized *.txt file (see chapter 4);
Click on the Perform checks button.

The results are shown on the output area
station
can be exported in text format by clicking on the Export table

Save log for each
button.

Please refer to the dedicated chapter for a full reference of the Verification tool.
Smart checking: allows to automatically select the proper verification on the base of the element material. In
addition, displays checking results filtered by transversal section.

WARNING: the selected codes for checking for each material are the same associated to the keys combinations
CTRL+1 6.
Fire checking: the command starts the first phase of the fire checks for the frame structures on the selected beam
elements.
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In the window that appears you can select:
- Analysis and design curves: select Eurocode 2 for structures in reinforced concrete, Eurocode 3 for steel, Eurocode 9
for aluminium;
- Load combination: select the exceptional load combination to use for quick verification;
- Section selection criterion: the section used for verification must meet the selected criterion (maximum moment My,
maximum moment Mz, maximum in both directions Myz)
- Sides exposed to fire for beams: the sides considered as exposed for the thermal analysis for the horizontal or subhorizontal elements;
- Sides exposed to fire for columns: the sides considered as exposed for the thermal analysis for vertical elements;
- Final fire analysis time in minutes: select the analysis time for which the resistant check of the section will be
conducted.
The Run all analyses option allows you to launch the files created in the same folder as the current model, saving the
results for each. The Show Results option displays the 500°C isotherm for each thermal analysis in a separate
window.

The command returns a table containing the demand / capacity ratios of the analysed sections in the Check-NMM
(pressure and bending) and Check-V (shear) columns. The images relating to the resistant verification are saved in
the same folder as the model (representation of the section and neutral axis, reduced resistant domain due to the
effect of fire).
Advanced data: Collects several commands for data analysis on the model.

-

Overturning check: executes the overturning check on the whole model, assuming it as a rigid body. This
command calculates the overturning and stabilizing contributions for each load present in the model
(except for thermal loads and distortions) and produces their summation.
The check is conducted with respect to rotation axes in XY plane, passing through the nodes bounded in Z
direction. The program can select automatically the 4 peripheral nodes or the user can specify such nodes.
It is possible to specify a rotation angle, defined in XY plane, for the rotation axis (default 0° = X global axis).
The checking is carried out automatically for the specified axis and its normal axis, producing a table with
each load case, containing base cases and combinations of type linear add, showing the overturning
moment. If this is negative, the configuration is stable. Otherwise, the structure is not.
WARNING: the overturning check is performed with respect to the only loads applied as forces,
concentrated of uniformly distributed. Applied moments and reactions are always neglected.
WARNING: linear distributed loads are not supported. The loading resultant is always assumed in the
middle of the loading span.
WARNING: the automatic algorithm for the seeking of nodes looks for all the nodes restrained in Z
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direction and assumes their maximum obstruction. Always check the position of the nodes restrained in Z

-

Sum of loads and masses: produces a report on the sum of reactions in Z direction for each base loadcase,
reporting also the summation of the masses present in the model.
WARNING: for wind loadcases, the returned value is the highest sum amongst the X, Y and Z directions,
calculated on reactions. For all the other cases, applied loads are summed.

-

IDEA Check Manager: this command executes IDEA StatiCa® Code Check Manager on selected nodes
and/or elements.
WARNING:
correctly set.

Model report: Produces a model report in PDF, RTF or DocX formats. Tick the proper items to export them.

Delete saved results:

2.10.
Help:

Allows the deletion of the saved results in the NXF file.

Help menu (?)
Opens the manual

Check for updates:
Checks if the program is updated. The sub-command
select further updates with minor changes and corrections.

allows to

Language:
You can choose the interface to be in English or Italian. You must restart the program for
the changes to take effect.
License:

Manage license requests.
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About:

Credits and licenses.
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3. Import/export features

3.1. Import
OpenSees
Pre-processing features:
-

-

-

Nodes
UniaxialMaterial (partial reading)
o elastic
o elasticPP
o elasticPPgap
o ENT
o Concrete01
o Concrete02
o Concrete03
o Steel01
o Steel02
NDMaterial
o ElasticIsotropic
Section (partial reading)
o Fiber
o PlateFiber
o LayeredShell
Elements
o ShellMITC4
o quad
o bbarQuad
o enhancedQuad
o quadUP (both)
o ShellDKGQ
o ShellNLDKGQ
o ShellNL (treated as 8-node shell)
o ElasticBeamColumn
o ElasticTimoshenkoBeam
o ForceBeamColumn
o DispBeamColumn
o beamWithHinges
o truss and trussf
o corotTruss
o rotspring2dir
o zeroLength
o zeroLengthND
o zeroLengthSection
o stdBrick
o bbarBrick
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-

o Brick8N
o brickUP
o Brick20N
o 20_8_BrickUP
Fix, fixX, fixY, fixZ Commands
GeomTransf Commands
Uniform Beam Loads
Nodal Loads

Post-processing features:
-

Displacements recorder
Reactions recorder
Modal Eigenvectors recorder
Custom spring data
WARNING: Import from OpenSees could be incomplete. Please always use recorder as complete as
-file disp.out -time -nodeRange 0 124 -dof 1 2 3 4 5 6

Midas GEN®
Pre-processing features:
-

-

-

Nodes
Elements
o Beam
o Truss
o Plate
o Wall
o Elastic link
Frame Sections
o Rectangular
o Circular
Plate and Wall sections
Material
Member assignments
Constraints
Frame releases
Static load cases
Load combinations
Distributed beam loads
Point loads
Beam rebar
Column rebar
Wall rebar

Post-processing features:
-

Beam forces from table
Nodal displacements from table

SAP2000®
To import a model from SAP2000®, click on the Import option in the File menu and choose the SAP2000 text
file (*.s2k) option from the file type drop-down list.
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The supported pre-processing features are:
-

-

Joint coordinates
Joint restraint assignments
Frame connectivity
Link connectivity
Area connectivity
General frame section properties
Area section properties
o Rectangular
o circular
General frame release assignments
Frame section assignments
Area section assignments
Basic mechanical material properties
Joint loads
Beam distributed loads
Load case definitions

Post-processing features:
-

Modal periods and frequencies
Joint displacements
Joint reactions
Frame element forces
Shell element forces
Shell element stresses

OOFEM
Pre-processing features:
-

Analysis type
Node
Rigidarmnode
Beam3D
Truss3D
quad1mindlinshell3d
mitc4shell
tr_shell01
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-

tr_shell02
LSpace
LTRSpace
QSpace

Post-processing features:
-

Node displacements
Node reactions
Element forces and moments
Element strains
Element stresses

ADAPTIC and Zeus-NL
Pre-processing features:
-

Materials
Groups
Structural Nodal Coordinates (with or without repetitions)
Non-structural Nodes (with or without repetitions)
Element connectivity (with or without repetitions)
o CBP3
o CBP2
o LNK3
o JEL3
o IN16 (partitioning supported)
o BK20 (partitioning supported)

Post-processing features for NUM files:
-

Nodal displacements
Nodal velocities (disable by default, check Options)
Nodal accelerations (disable by default, check Options)
Reactions
Frame diagrams for cbp2, cbp3, lnk3 (in global coordinates), jel3.

ABAQUS® and CalculiX
Pre-processing Import features:
-

Nodes
Element
o B22
o B23
o B31
o B33
o S3
o CPS3
o S4
o S4R
o CPS4
o C3D4
o C3D10
o C3D8
o C3D20

Post-processing features:
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-

Not available yet

Dxf drawing
Pre-processing features:
- Points
- Line elements
WARNING: The correctness of the results is not guaranteed. Check carefully your model after import.
Straus7®
Pre-processing features:
BIM files

Units
Nodes
Beam
Beam3
Tri3
Quad4
Hexa8
Beam rotation angles
Restraints
Rigid links
Master-slave links
Masses
Beam sections (rectangular, round, I, angle)
Shell sections
Nodal forces
Global distributed forces on beams
Local distributed forces on beams
IFC and IFCxml

Import of BIM models is supported for IFC and IFCxml formats. During import, IfcWall elements are automatically
meshed with quad elements in a structured mesh. The mesh dimension can be set in the program options.
Therefore, tolerances on position of windows and doors do not exceed the half of mesh size.
The following elements can be read:
-

IfcBeam (Swept Solid body, Axis 2d and Mapped body representations)
IfcColumn (Swept Solid body, Axis 2d and Mapped body representations)
IfcWall (Swept solid representations)
IfcSlab (Swept solid representations)
IfcFooting (Swept solid representations)
IfcReinforcingBar
IfcStructural classes.
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3.2. Export
ABAQUS®
-

Nodes
Elements
o B33
o CPE2
o CPS3
o S3
o CPE4
o CPS4

OpenSees
-

-

Nodes
Elements
o elasticBeamColumn
o ShellMITC4
o twoNodeLink (for springs)
o stdBrick
o Brick20N
Sections
o PlateFiber
Isotropic Materials
o nDMaterial ElasticIsotropic
Restraints
Nodal loads

Midas GEN®
-

-

Nodes
Elements
o Beam
o Triangular plates
o Quadrilateral plates
Groups
Isotropic materials
Wall and plate sections
Restraints
Elastic link
Nodal masses
Loads cases
Concentrated loads
Beam distributed loads

SAP2000®
-

Joints
Frame connectivity
Area connect
Basic material properties
Frame sections

-

Area section (
WARNING: thick shells with drilling DOFs)
Section assignments

-

Load cases (

WARNING: Self weight set to zero)
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-

Restraints

-

Linear links(
WARNING: not yet supported)
Concentrated masses
Concentrated loads
Beam distributed loads
Groups

-

-

Analysis
o Linear static
Nodes
Elements
o Beam3D
o Truss3D
o Tr_shell01
o Quad1mindlinshell3d
o Lumped mass
o LTRSpace
o LSpace
o QSPace
Sections
Isotropic materials
Boundary conditions
Sets

-

Points
Line elements

-

Plain elements (

OOFEM

-

Dxf

BIM files

WARNING: triangular and quadrilateral only)

IFC e IFCxml
-

IfcBeam (Swept Solid body, Axis 2d and Mapped body representations)
IfcColumn (Swept Solid body, Axis 2d and Mapped body representations)
IfcWall only for walls defined as group of shell (see Edit/Mesh wall command) (Swept solid
representations)
IfcSlab (Swept solid representations)
IfcFooting (Swept solid representations)
IfcReinforcingBar for longitudinal rebar and stirrups.

IDEA StatiCa 10
For steel structures, the entire model is exported. To design the joint in IDEA StatiCa Connection, the corresponding
Edit/Change element type.

WARNING: the correct export of geometry and results is not guaranteed.
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4. Customization

4.1. Expand material library
The material library can be expanded by writing a CSV file (i.e. a text file using the semicolon separator), as in the
following examples.
-

Steel

Name;Code;E [MPa];G [MPa];n_;fyk [MPa];ftk [MPa];Wd [kN/m^3];Md [ton/m^3];CheckType
S235;UNI EN 10025-2;210000;80769;0.3;235;360;78.6;0.801;1
S275;UNI EN 10025-2;210000;80769;0.3;275;430;78.6;0.801;1

-

Concrete

Name;Code;E [MPa];G [MPa];n_;fck [MPa];Wd [kN/m^3];Md [ton/m^3];CheckType
C8/10;NTC2008;25331;10555;0.2;8;25;254.841998
C12/15;NTC2008;27085;11285;0.2;12;25;254.841998

The column CheckType specifies the verifications associated with the material. Insert:
-

1 for Steel
2 for Aluminium/Alloy
3 for Concrete
4 for Timber
0 for other materials.

For other types of materials, all the columns are mandatory,
by the program in consistent units from Wd weight density.

Md

mass density, which will be calculated

Natively supported fields are:

-

E: Young modulus
n_: Poisson ratio
G: shear modulus
fk: characteristic strength
Wd: weight density
a_T: thermal coefficient for linear deformation
K: heat conductivity
Cp: specific heat capacity

The

extension must be *.nfm.
4.2. Expand section Library

The section library can be expanded by writing a CSV file (i.e. a text file using the semicolon separator) as follows:
Name;Code;h [mm];b [mm];tw [mm];tf [mm];r [mm];A [cm^2];Jy [cm4];Wey [cm^3];Wpy [cm^3];iy [cm];Avz [cm^2];Jz [cm^4];Wez [cm^3];Wpz [cm^3];iz [cm]
IPE A 80;UNI;78;46;3.3;4.2;5;6.375401837;64.37774091;16.50711305;18.97743881;3.177708713;3.070001837;6.852668856;2.979421242;4.692462888;1.036754887

…
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The first four columns are mandatory.
Natively supported fields are:

-

h: height
b: base
d: diameter
t: thickness (for pipe sections)
tw: web thickness
tf: flange thickness
A: area of the section
Jz: moment of inertia with respect to horizontal axis
Jy: moment of inertia with respect to vertical axis
Wez: elastic strength modulus with respect to horizontal axis
Wey: elastic strength modulus with respect to vertical axis
Wpz: plastic strength modulus with respect to horizontal axis
Wpy: plastic strength modulus with respect to vertical axis
Avz: shear area with respect to horizontal axis (local z)
Avy: shear area with respect to horizontal axis (local y)
gap: horizontal distance for double sections (eg. double L or double C).

The property name can be fo
The Type columns specifies the shape of the section. Insert:

-

0 for unknown or generic
1 for rectangular
2 for circular
3 for C shape
4 for T shape
5 for double-T o I
6 for L shape
7 for box
8 for pipe
9 for double L
10 for double C.
*.nfs.

4.3. Custom verifications
It is possible to customize the list of verifications with the notation described in the following. The text file
verification
nvv
(see for example trusses.nvv). Such file can be edited with Notepad++ (https://notepad-plusplus.org/). A setting
verification
(NextFEMVerifications.xml).
The checking engine supports the code execution in blocks. Each block is delimited by the identifiers as in the
following example and must the named with a floating point number (0.6).

$$0.6
# this is a comment
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execif(SecType==1,1.0)

$!
To call each block, the following keywords are available:
-

exec(0.6) : executes the code block named 0.6
execif(condition, 0.6): executes the code block named 0.6 is condition is true;
execwhile(condition, 0.6): executes the code block named 0.6 while condition is true. The variable exitdo
equal to 1 within the code block forces the exit. Limited to 10000 cycles.

Formulas can be written using the following operators/functions:
Addition: +
Subtraction: Multiplication: *
Division: /
Modulo: %
Exponentiation: ^
Less than: <
Less than or equal: <= or
More than: >
More than or equal: >= or
Equal: ==
Not Equal: != or
Sine: sin
Cosine: cos
Arcsine: asin
Arccosine: acos
Tangent: tan
Cotangent: cot
Arctangent: atan
Arc cotangent: acot
Natural logarithm: loge
Common logarithm: log10
Logarithm: logn
Square root: sqrt
Conditional key: if(var<var2,1,0)
Boolean operator: and(cond1,cond2)
Boolean operator: or(cond1,cond2)
Boolean operator: not(cond)
The hardcoded variables are:
-

Model units handling
o unitconv: converts between units. Usage: unitconv(oldUnits,newUnits,Value).
Example: Eps=sqrt(235/unitconv(model_S,MPa,fk))
converts fk from stress units in the model to MPa
o rcsect: calculates resisting moments of a RC section, storing them in Mry and Mrz. Usage:
rcsect(N,Myy,Mzz)
o skipItem: if =1, skips the subsequent checking. To be used only in the time-dependent load
cases (for example, linear dynamic analysis)
o model_L: placeholder for the length unit in the model
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o
o
o
o
o
o
o
o

o
o

o

o

o
o
o
o

o

model_F: placeholder for the force unit in the model
model_FL: placeholder for the force per length unit in the model
model_T: placeholder for the temperature unit in the model
model_M: placeholder for the mass unit in the model
model_S: placeholder for the stress unit in the model
isVarDefined(var): checks if a variable is defined (1) or not (0)
Halt: stops the execution;
addUtable: adds an user table at runtime, and returns the ID of the table. Usage:
addUtable(numColumns, columnsHeaders, data by row including row header). Example:
tid=addUtable(3,1,2,3,100,4,5,6,101,4,5,6,102,4,5,6,103,4,5,6)
adds the following table:
1

2

3

100

4

5

6

101

4

5

6

102

4

5

6

103
4
5
6
UtableAt: returns the value at i, j of a table. Usage: UtableAt(table ID,i,j)
UtableInterpValues: gives the bilinear interpolation for the table. Usage:
results=UtableInterpValues(table ID, value on row headers, value on column headers).
Example: res1= UtableInterpValues(tid,101.3,2.5) gives 5.5 as a result.
addRebar: adds longitudinal rebar to the current element.
The function returns -1 if it fails or design material cannot be found.
The function returns -2 is the bar falls outside the section.
If a bar already exist in the desired position, the function updates it only if area of the new
rebar is higher.
Usage: addRebar(zCoord, yCoord, rebarArea, design material ID, startAt [0,1), endAt (0,1] ).
Example: addRebarL(40,40,201.0,2,0,1)
adds a rebar of area 201.0 at position 40, 40 from the bottom left corner of the section, for the
whole element.
addStirrups: adds stirrups to the current element.
The function returns -1 if it fails or design material cannot be found.
If stirrups are still present, the function updates them only if new ones have better
characteristics (e.g. lesser spacing, higher diameter).
Usage: addStirrups(legs in Y, legs in Z, single bar area, spacing, design material ID, startAt [0,1),
endAt (0,1] ).
Example: addStirrups(2, 2, 50.0, 200, 2, 0,1)
adds 2-by-2 legs stirrups, each one of area 50.0, at 200 of spacing, for the whole element.
clearRebar: clear all rebar, including stirrups, in the current element.
getBarDiam: gets the minimum diameter of a longitudinal bar required to satisfy the given
area. The output is in mm. Example: getBarDiam(2.01) # for a model in cm, returns 16.
getStirrupDiam: gets the minimum diameter of a stirrup bar required to satisfy the given
area. The output is in mm. Example: getStirrupDiam(0.5) # for a model in cm, returns 8.
TranslateMomentZZ: gives maximum and minimum moments around z local axis for the
given position, translated by a quantity delta. Syntax: TranslateMomentZZ(position, delta). The
argument position is contained in the built-in dataset for elements in the variable pos. This
function returns or overwrite the variables Mzzmax and Mzzmin.
TranslateMomentYY: gives maximum and minimum moments around y local axis for the
given position, translated by a quantity delta. Syntax: TranslateMomentYY(position, delta). The
argument position is contained in the built-in dataset for elements in the variable pos. This
function returns or overwrite the variables Myymax and Myymin.
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o

o
o
o

FireSectionStrength: loads a thermal map of a section and use it to estimate element
strength. It is available in the FireSafe module. The filename containing thermal results for the
fireSect
FireSectionStrength(station). The argument station is the checking station, typically from 1 to
5.
round: round a floating point number to the nearest integer. Ex. round(12.6) returns 13.0.
ceil: round up a floating point number. Ex. ceil(12.3) returns 13.0.
floor: round down a floating point number. Ex. floor(12.6) returns 12.0.

-

Built-in general dataset:
o ServType: indicates if the current serviceability combination is characteristic (rare) (1),
frequent (2) or quasi-permanent (2). The value is 0 if the combination is not of serviceability
type.
o Seismic: indicates if the current combination is seismic (1) or not (0). The value 1 is always
associated to ServType=0.
o time: current time.

-

Built-in dataset for elements:
o A: Area
o Jz: Moment of inertia around z-axis
o Jy: Moment of inertia around y-axis
o Jmin: Minimum moment of inertia
o Jt: Torsional Inertia
o D: Diameter of circular cross sections
o Di: Inner diameter of pipe cross sections
o te: Thickness of pipe cross sections
o b: Base for any other cross sections
o h: Height for any other cross sections
o tw: web thickness
o tf1: thickness of bottom flange
o tf2: thickness of upper flange
o t: thickness for planar sections
o N: Axial force of the current section of a beam
o Vy: Shear force along y direction of the current section of a beam
o Vz: Shear force along z direction of the current section of a beam
o Mt: Twisting moment of the current section of a beam
o Myy: Moment around y local axis of the current section of a beam
o Mzz: Moment around z local axis of the current section of a beam
o rMyIJ: ratio between Myy at end I and at end J of the beam
o rMzIJ: ratio between Mzz at end I and at end J of the beam
o MmaxY: maximum moment around y axis for the whole element or member
o MmaxZ: maximum moment around z axis for the whole element or member
o MminY: minimum moment around y axis for the whole element or member
o MminZ: minimum moment around z axis for the whole element or member
o Em: material Young modulus
o Gm: material shear modulus
o NIm
o fk: material characteristic strength
o WelZ: section modulus for z axis
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-

WelY: section modulus for y axis
WplZ: plastic section modulus for z axis
WplY: plastic section modulus for y axis
iz: radius of inertia for z axis
iy: radius of inertia for y axis
imin: minimum radius of inertia
SecType: 1=beam, 2=planar, 0=unknown
SecBeamType: 0=unknown, 1=rectangular, 2=circular, 3=Cshape, 4=Tshape,
5=DoubleTshape, 6=Lspahe, 7=box, 8=pipe
MatType: type of material. Steel 1, Aluminium 2, Concrete 3, Timber 4, Masonry 5, Fragile in
tension 6, unknown 0.
dx: axial relative displacement along beam axis
dy: transversal deflection in local direction y
dz: transversal deflection in local direction z
L0yy: buckling length for bending around y local axis
L0zz: buckling length for bending around z local axis
L0: maximum buckling length between L0yy and L0zz
pos: of the current section of a beam, in model units
LvyI: contraflexure length from end I, ratio Myy/Vz in station 1
LvyJ: contraflexure length from end J, ratio Myy/Vz in station 5
LvzI: contraflexure length from end I, ratio Mzz/Vy in station 1
LvzJ: contraflexure length from end J, ratio Mzz/Vy in station 5
fxx: force in x local direction (element centre)
fyy: force in y local direction (element centre)
fxy: shear force in xy direction (element centre)
fzz: force in z local direction (element centre)
fxz: shear force in xz direction (element centre)
fyz: shear force in yz direction (element centre)
mmxx: moment around x local direction (element centre)
mmyy: moment around y local direction (element centre)
mmxy: moment around xy direction (element centre)
mmzz: moment around z local direction (element centre)
mmxz: moment around xz direction (element centre)
mmyz: moment around yz direction (element centre)
time: current time step
temp: average element temperature in the current step
isWall: if wall groups is defined for the current planar element returns 1, 0 otherwise.
Column: if the current beam element is vertical returns 1, 0 otherwise. It is not defined for
other types of elements.

Built-in dataset for nodal results:
o dx: nodal displacement in X direction
o dy: nodal displacement in Y direction
o dz: nodal displacement in Z direction
o rx: nodal rotation around X axis
o ry: nodal rotation around Y axis
o rz: nodal rotation around Z axis
o vx: nodal velocity in X direction
o vy: nodal velocity in Y direction
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vz: nodal velocity in Z direction
vrx: nodal velocity around X axis
vry: nodal velocity around Y axis
vrz: nodal velocity around Z axis
ax: nodal acceleration in X direction
ay: nodal acceleration in Y direction
az: nodal acceleration in Z direction
arx: nodal acceleration around X axis
ary: nodal acceleration around Y axis
arz: nodal acceleration around Z axis
Rex: nodal reaction in X direction
Rey: nodal reaction in Y direction
Rez: nodal reaction in Z direction
Rerx: nodal reaction around X axis
Rery: nodal reaction around Y axis
Rerz: nodal reaction around Z axis
sxx: nodal stress in X direction
syy: nodal stress in Y direction
sxy: nodal shear stress in XY direction
szz: nodal stress in Z direction
sxz: nodal shear stress in XZ direction
syz: nodal shear stress in YZ direction
fxx: nodal force in X direction
fyy: nodal force in Y direction
fxy: nodal shear force in XY direction
fzz: nodal force in Z direction
fxz: nodal shear force in XZ direction
fyz: nodal shear force in YZ direction
mxx: nodal moment around X direction
myy: nodal moment around Y direction
mxy: nodal moment around XY direction
mzz: nodal moment around Z direction
mxz: nodal moment around XZ direction
myz: nodal moment around YZ direction
time: current time step
temp: nodal temperature in the current step.
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5. Getting started and validation

5.1. Tutorial One
This tutorial will show how to model a 5 metres long fixed-ended beam, loaded with concentrated loads of 10kN in
directions x, y and z in the middle of its span. The results from NextFEM Designer (Frame forces and displacement)
are compared with hand calculations.
WARNING: Both flexural and shear deformations are considered. To enable this option, click on
Tools>Option>Solver and check the Include shear deformations in beam elements tick under the
OOFEM preferences box
The following sequence of operations are needed to create the model:
1.

Set the Units: N for force and mm for length.

2.

Define the Material properties:
o Name: Concrete;
o E=30000 N/mm2;
o Nu=0.3
o Fk=25 N/mm
o Weight=2.5e-5 N/mm3;
o Mass=2.55e-9 N/mm2/g
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3.

Define the Section properties:
o b=300 mm (z direction);
o h=500mm (y direction);

4.

Define the Loads cases: Only one load case called Qk1 is considered
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5.

Insert the Geometric properties using Node by Coordinates:
o L=5000 mm;
o Distance from fixed end to loads=2500 mm;

6.

Insert the beams using the Beam command.

7.

Assign the boundary conditions using the Restraints command: fix all DoFs for nodes 1 and 3.

8.

Assign the material using the Assign>Material command at the beams by selecting them and then
click on Assign to selected elements
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9.

Assign the section using the Assign>Section command at the beams by selecting them and then
click on Assign

10. Assign the point load to the node number 2.
o Px=10000 N;
o Py=10000 N;
o Pz=-10000 N.

11. Run the analysis.

o

Results:
Displacement in x direction: Node 2=0.002778mm
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o

Displacement in y direction: Node 2=0.2016mm

o

Displacement in z direction: Node 2=-0.00781 mm
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o

Moment Diagram: Values from Results>Extract Data
 Mzz



Myy
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o

Shear Diagram:


Vy



Vz
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o

Normal forces Diagram:

o

Internal displacements in y direction: values from Results>Extract data
Position [mm]

Displacement [mm]

0

0

281.8

0.00778

1250

0.1008

2218

0.1938

2500

0.2016

2500

0.2016

2781.8

0.1938
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o

-

3750

0.1008

4718

0.00778

5000

0

Internal displacements in z direction: values from Results>Extract data
Position [mm]

Displacement [mm]

0

0

281.8

-0.003424

1250

-0.03906

2218

-0.07469

2500

-0.07811

2500

-0.07811

2781.8

-0.07469

3750

-0.03906

4718

-0.003424

5000

0

Hand Calculations:
o Section properties

A  b  h  150000mm 2
bh3
 3125e6mm 4
12
hb3
Jz 
 1125e6mm 4
12
Moment diagram:
 Mzz
Jy 

o

M max 

Pz l
Pl
 6250000 Nmm ; M min   z  6250000 Nmm
8
8

 Myy
Py l
Py l
M max 
 6250000 Nmm ; M min  
 6250000 Nmm
8
8
o Shear Diagram:
 Vy
Pz
P
Vmax 
 5000 N ; Vmin   z  5000 N
2
2
 Vz
Py
Py
Vmax 
 5000 N ; Vmin    5000 N
2
2
o Axial force Diagram:

N max 
o

Px
P
 5000 N ; N min   x  5000 N
2
2

Displacement in x direction: Node2
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u2, x 
o

Displacement in y direction: Node 2

u2, y 

o

ux, y

ux, y

3
Py l
1 Py l

 0.201568mm
192 EJ z
4GA

Displacement in z direction: Node 2

u2, z 

o

N max (l / 2)
 0.00278mm
EA

Pl
1 Pz l 3
  z  0.07811mm
192 EJ y
4GA

Displacement in y direction: internal point at the coordinate x
3

Py x 2  l  2 x 
1
2

   Py x for

24
EJ z
2GA

0 x L/2

L
2
Py  L  x   2 x  
Py  L  x 
1
2



for
24
EJ z
2GA

L/2 x L

Position [mm]

Displacement [mm]

0

0

281.8

0.00778

1250

0.1008

2218

0.1938

2500

0.2016

2500

0.2016

2781.8

0.1938

3750

0.1008

4718

0.00779

5000

0

o

Displacement in z direction: internal point at the coordinate x

ux, z

1

24

3

Pz x 2  l  2 x 
2
   Pz x
for
EJ y
2GA

ux,z

1

24

L
2
Pz  L  x   2 x  
P  L  x
2

 z
for
EJ y
2GA

0 x L/2

L/2 x L

Position [mm]

Displacement [mm]

0

0

281.8

-0.003425

1250

-0.03906
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2218

-0.07468

2500

-0.07811

2500

-0.07811

2781.8

-0.07469

3750

-0.03906

4718

-0.003429

5000

0

5.2. Tutorial Two
The second tutorial consists in a cantilever beam loaded with points load in directions y and z. The output results of
NextFEM Designer (Frame forces and displacement) are compared with hand calculations.
Case a
Only flexural deformations are considered.
-

-

-

Units: N for forces and mm for lengths.
Material Properties:
o Name: Concrete;
o E=30000 N/mm2;
o Nu=0.3
o Fk=25 N/mm
o Weight=2.5^10-5 N/mm3;
o Mass=2.55^10-9 N/mm2/g
Section properties:
o B=300 mm (z direction);
o H=500mm (y direction);
Geometric properties:
o L=2500 mm;
Loads:
o Py=5000 N;
o Pz=-10000 N.
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o

results:
Displacement in x direction: Node 2=0.00mm

o

Displacement in y direction: Node 2=0.7716mm

o

Displacement in z direction: Node 2=-0.5556mm
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o

Moment Diagram: Values from Results>Extract Data
 Mzz



Myy
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o

Shear Diagram:
 Vy



Vz
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o

o

-

Internal displacement in y direction: values from Results>Extract data
Position [mm]

Displacement [mm]

0

0

281.8

0.01415

1250

0.2411

2218

0.6417

2500

0.7716

Internal displacement in z direction: values from Results>Extract data
Position [mm]

Displacement [mm]

0

0

281.8

-0.01019

1250

-0.1736

2218

-0.4620

2500

-0.5556

Hand Calculations:
o Moment diagram:
 Mzz
M max  Pz l  25000000 Nmm ;



Myy

M max  Py l  12500000 Nmm
o

Shear Diagram:
 Vy
100

Vmax  Pz  10000 N ;

 Vz
Vmax  Py  5000 N ;
o

Axial force Diagram:

N max  0 N ;

o

Displacement in x direction: Node 2

u2, x  0
o

Displacement in y direction: Node 2
3

u2, y 

o

Displacement in z direction: Node 2

u2, z 

o

1 Pz l 3
 0.0.5556mm
3 EJ y

Displacement in y direction: point at coordinate x

ux, y 

o

1 Py l
 0.77160mm
3 EJ z

2
1 Py x  3l  x 
6
EJ z

Coordinate x [mm]

Displacement [mm]

0

0

281.8

0.01415

1250

0.2411

2218

0.6416

2500

0.7716

Displacement in z direction: point at coordinate x

ux, z 

2
1 Pz x  3l  x 
6
EJ y

Coordinate x [mm]

Displacement [mm]

0

0

281.8

-0.01019

1250

-0.1736

2218

-0.4620

2500

-0.5556

Case b
Both flexural and shear deformations are considered. To enable this option, click on
Tools>Option>Solver and check the Include shear deformations in beam elements tick under the
OOFEM preferences box
- Units: N for forces and mm for lengths.
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-

-

-

Material Properties:
o Name: Concrete;
o E=30000 N/mm2;
o Nu=0.3
o Fk=25 N/mm
o Weight=2.5^10-5 N/mm3;
o Mass=2.55^10-9 N/mm2/g
Section properties:
o B=300 mm (z direction);
o H=500mm (y direction);
Geometric properties:
o L=2500 mm;
Loads:
o Py=5000 N;
o Pz=-10000 N.

o

Displacement in x direction: Node 2=0.00mm
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o

Displacement in y direction: Node 2=0.7803mm

o

Displacement in z direction: Node 2=-0.5729mm
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o

Moment Diagram: Values from Results>Extract Data
 Mzz



Myy
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o

Shear Diagram:
 Vy



Vz
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o

o

-

Internal displacement in y direction: values from Results>Extract data
Position [mm]

Displacement [mm]

0

0

281.8

0.01513

1250

0.2455

2218

0.6494

2500

0.7803

Internal displacement in z direction: values from Results>Extract data
Position [mm]

Displacement [mm]

0

0

281.8

-0.01214

1250

-0.1823

2218

-0.4774

2500

-0.5729

Hand Calculations:
o Moment diagram:
 Mzz
M max  Pz l  25000000 Nmm ;



Myy

M max  Py l  12500000 Nmm
o

Shear Diagram:
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Vmax

 Vy
 Pz  10000 N ;

Vmax

 Vz
 Py  5000 N ;

o

Axial force Diagram:

N max  0 N ;

o

Displacement in x direction: Node 2

u2, x  0mm
o

Displacement in y direction: Node 2

u2, y 

o

Displacement in y direction: point at coordinate x

ux, y 

o

2
Py x
1 Py x  3l  x 

6
EJ z
GA

Coordinate x [mm]

Displacement [mm]

0

0

281.8

0.01513

1250

0.2455

2218

0.6493

2500

0.7803

Displacement in z direction: Node 2

u2, z 

o

3
Py l
1 Py l

 0.7803mm
3 EJ z
GA

Pl
1 Pz l 3
  z  0.5729mm
3 EJ y
GA

displacement in z direction: point at coordinate x

ux, z 

2
Px
1 Pz x  3l  x 
 z
6
EJ y
GA

Coordinate x [mm]

Displacement [mm]

0

0

281.8

-0.01214

1250

-0.1823

2218

-0.4773

2500

-0.5729
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5.3. Tutorial Three
The third tutorial consists in a cantilever beam loaded with points load in direction y with modelled by shell
elements (Mindlin-Reissner theory). The output results of NextFEM Designer (Frame forces and displacement) are
compared with hand calculations.
Only flexural deformations are considered.
-

-

-

Units: N for forces and mm for lengths.
Material Properties:
o Name: Concrete;
o E=30000 N/mm2;
o Nu=0.3
o Fk=25 N/mm
o Weight=2.5^10-5 N/mm3;
o Mass=2.55^10-9 N/mm2/g
Section properties:
o B=300 mm (y direction); Planar section;
Geometric properties:
o L=5000 mm;
Loads:
o Py=5000 N;
o Pz=10000 N;
Mesh size: 250x250 mm

o

Displacement in x direction: Node 2=0.00mm
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o

Displacement in y direction: Node 2=0.6250 mm

o

Displacement in z direction: Node 2=-0.5062mm
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-

Comparison with hand Calculations (see tutorial two):
o Displacement in y direction
 Hand Calculation: 0.77160mm
 NextFEM designer: 0.6250mm
 Percent difference 19%
o Displacement in z direction:
 Hand Calculation: -0.5556mm
 NextFEM designer: -0.5062mm
 Percent difference: 9%

Note that the difference is due to the choice of the mesh size.
5.4. Tutorial Four
The fourth tutorial consists in a cantilever beam loaded with distributed loads in directions x, y and z. The output of
NextFEM Designer (Frame forces and displacement) is compared with hand calculations.

Only flexural deformations are considered.
-

Units: N for forces and mm for lengths.
Material Properties:
110

-

-

o Name: Concrete;
o E=30000 N/mm2;
o Nu=0.3
o Fk=25 N/mm
o Weight=2.5^10-5 N/mm3;
o Mass=2.55^10-9 N/mm2/g
Section properties:
o B=300 mm (y direction);
o H=500mm (z direction);
Geometric properties:
o L=5000 mm;
Loads properties:
o qy=1 N/mm;
o qz=-1 N/mm;
o qx=-1 N/mm.

o

Displacement in x direction: Node 6=-0.00278mm

o

Displacement in y direction: Node 6=2.315mm
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o

Displacement in z direction: Node 6=-0.8333mm

o

Moment Diagram: Values from Results>Extract Data
 Mzz max: node 1: 125000000000 Nmm



Myy max: node 1: 125000000000 Nmm
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o

Shear Diagram:
 Vy



-

Vz

Hand Calculations:
o Moment diagram:
 Mzz

M max 

qz l 2
 125000000000 Nmm ;
2
 Myy
113

M max 

qy l 2
2

 125000000000 Nmm ;

o

Shear Diagram:
 Vy
Vmax  qz l  5000 N ;

Vmax

 Vz
 q y l  5000 N ;

o

Axial force diagram:

N max  qx l  5000 N ;

o

Max Displacement in x direction: Node 6

u6, x 
o

Max Displacement in y direction: Node 6

u6 y 

o

qx l 2
 0.00278mm
2 EA

qyl 4
8EJ y

 2.315mm

Max Displacement in z direction: Node 6

u6, z 

qz l 4
 0.8333mm
8EJ z

5.5. Tutorial Five
The fifth tutorial consists in a modal analysis of a 3D wooden frame-building . The output of NextFEM Designer
(modes of vibration) is compared with the output of SAP2000®.

Only flexural deformations are considered.
-

Units: kN for forces and m for lengths.
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-

-

-

-

Material Properties:
o Name: GL24H;
o E=9.40^10+6 kN/m2;
o Nu=0.3
o Weight=3.8 kN/m3;
o Mass=0 kN/m3/g
Section properties:
o B=300 mm (y direction);
o H=500mm (z direction);
Geometric properties:
o Lx=3 m;
o Ly=4m;
o Lz=2m;
Mass properties: at every nodes of the 1st storey
o my=2.5 kN/g;
o mz=-2.5 kN/g;
o mx=-2.5 kN/g

o

First mode:

o

Second mode:
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o

-

Third mode:

SAP2000® results:
o First mode:
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o

Second mode:

o

Third mode:

The test model, calculated with two different programs, exhibits comparable results.
5.6. Tutorial Six
The sixth tutorial consists in a response spectrum analysis of a 3D wooden frame-building, as showed in tutorial five.
The acceleration spectrum employed is generated from inside the Functions form, and it is consistent with the
Eurocode 8 Type 1 spectrum, on soil A and with PGA 0.35g.

The Response Spectrum linear dynamic analysis is performed separately in each spatial direction.
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WARNING: all the results given by a ResponseSpectrum analysis must be interpreted without sign.

5.7. Tutorial Seven
The sixth tutorial consists in a buckling analysis of a simply supported concrete column. The output of NextFEM
Designer (i.e. the eigenvalues representing the load multipliers) is compared with the results computed by the
Eulerian instability theory. The column is meshed into 5 elements of equal length.
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Only flexural deformations are considered.
-

-

-

Units: kN for forces and m for lengths.
Material Properties:
o Name: C25/30;
o E=3.15e+6 kN/m2;
o =0.2
o Weight =25 kN/m3;
o Mass =2.5 kN/m3/g
Section properties:
o B=100 mm (z);
o H=200 mm (y);
Geometric properties:
o Ltot=3.0 m;
Loads:
o Qz=-1 kN;

o

First mode:
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o

Second mode:

o

Third mode:
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o

Fourth mode:

o

Fifth mode:

121

-

Manual calculation:
o

The critical load is computed as come Pcr   2

o

of the direction of inflection.
Section inertia:

J yy 

1 3
hb  16.7 106 mm4
12

J zz 

1 3
bh  66.7 106 mm4
12

o

2
2

l / n

2

with

n  1, 2,3,... , and the inertia J

Theoretical results:
Bending around yy

2

EJ

EJ yy
l2
EJ yy

Bending around zz

 575kN ,   575

2

 2301kN ,   2301

2

 5178kN ,   5178

l / 2
EJ yy

 l / 3

EJ zz
 2301kN ,   2301
l2
EJ zz
2
 9206kN ,   9206
2
l / 2

2
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6. License Terms

END USER LICENSE AGREEMENT
By using the software provided by NextFEM SRLS, user explicitly agreed to the following terms and conditions. The contents of
NextFEM website and of the supplied software, including the following license terms, could be changes and/or updated at any
time. By using the software supplied by NextFEM SRLS or our website, the privacy policy of NextFEM SRLS, published on
https://www.nextfem.it/it/privacy-policy/, is accepted.
Art. 1 User license
1. On the basis of the following terms and conditions, NextFEM SRLS, in the person of its in office pro tempore legal
for Windows® operating system, including manuals and documentation. The license hereby granted is not exclusive and not
transferable
in
any
case.
2. The present agreement does not transfer to the Licensee the source code of the supplied software, neither the logic and/or
design documentation.
Art. 2 Duration Agreement termination
1. The present agreement is valid for one year, starting from the license issue date. At the end of the year, this agreement will be
considered automatically rescinded, unless a renewal request by the Customer is received by NextFEM SRLS via email at
licensing@nextfem.it at least 30 days before the license expiration, or unless the Customer buys the renewal. Different conditions
may apply for Educational licenses.
2. NextFEM SRLS has the right to terminate earlier the present agreement due to gross negligence or wilful misconduct of the
Customer and/or for violations of the present agreement. Termination will be communicated via email to the address supplied
or
damage.
Art. 3 - License delivery 1. The free software provided by NextFEM SRLS which is freely available can be independently downloaded by the Customer
from the site nextfem.it.
2. The paid software provided by NextFEM SRLS which is subjected to a fee can be independently downloaded by the Customer
from the site nextfem.it. License request are fulfilled by the Licensor in the indicative and not binding term of 7 days after the
reception of the payment. Different conditions may apply for Educational licenses.
3. In any case, NextFEM SRLS is not responsible of any damage directly or indirectly connected to delays not dependent on its
will during the release of the license.
Art. 4 Installation 1. NextFEM software is auto-installing. Once the installation is performed, the software is considered as accepted by the
Customer.
2. Any other service (e.g. installation, verification, assistance requested by the Customer to let his employees to use NextFEM
and its acceptance by the Customer.
3. The Customer is solely responsible that his technological equipment (hardware and software) meets the minimum and
am.
Art. 5 Programs usage
1. The Customer must use NextFEM software for lawful and legal purposes.
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2. The Customer undertakes to not remove or alter any trademarks, serial number or other information related to right
reservation, which are included in software produced by NextFEM SRLS, even after the termination of the present agreement.
3. According to the Italian law art. 64 ter Law 22nd of April 1941, n. 633 as amended and supplemented and art. 5 par. 2 Directive
2009/24/EC of the European Parliament and of the Council of 23 April 2009 as amended and supplemented, it is allowed to the
Licensee Customer, having the right to use a copy of the software produced by NextFEM SRLS, to make a back-up copy of the
software and of the included documentation, so far as it is necessary for that use.
4. According to the Italian law art. 64 bis, lett. a) and b) ,64 ter Law 22nd of April 1941, n. 633 as amended and supplemented and
art. 4 par. 1 lett. a) and b) Directive 2009/24/EC of the European Parliament and of the Council of 23 April 2009 as amended and
supplemented, it is explicitly forbidden to the Customer the permanent or temporary reproduction of the software produced by
NextFEM SRLS and of the included documentation, by any means and in any form, in part or in whole, without the authorisation
by the right-holder. In so far as loading, displaying, running, transmission or storage of the aforementioned software necessitate
such reproduction, even such acts shall be subject to authorisation by the right-holder. At the same conditions and with the
same restrictions, it is equally forbidden to the Customer the translation, adaptation, arrangement and any other alteration of the
software produced by NextFEM SRLS and of the included documentation and the reproduction of the results thereof, without
prejudice to the rights of the person who alters the program.
5. The acts of the aforementioned paragraphs 2 and 3, even when they are necessary for the use of the aforementioned software
by the lawful Licensee Customer in accordance with its intended purpose, including for error correction, are subjected to the
authorisation by the right-holder.
6. According to the Italian law art. 64 ter, subparagraph 3 Law 22nd of April 1941, n. 633 as amended and supplemented and art. 5
par. 3 Directive 2009/24/EC of the European Parliament and of the Council of 23 April 2009 as amended and supplemented, it is
allowed to the Licensee Customer to observe, study or test the functioning of the software produced by NextFEM SRLS and of
which he holds the License, in order to determine the ideas and principles which underlie any element of the program if he does
so while performing any of the acts of loading, displaying, running, transmitting or storing the program which he is entitled to
do.
7. According to the Italian law art. 64 quater Law 22nd of April 1941, n. 633 as amended and supplemented and art. 6 Directive
2009/24/EC of the European Parliament and of the Council of 23 April 2009 as amended and supplemented, the previous
authorisation of NextFEM SRLS shall not be required where reproduction of the code and translation of its form within the
meaning of art. 64bis, lett. a) and b) Law 22nd of April 1941, n. 633 as amended and supplemented and of points (a) and (b) of
Article 4 par.1 are done to modify the form of the code and are indispensable to obtain the information necessary to achieve the
interoperability of an independently created computer program with other programs, provided that the following conditions are
met:
(a) those acts are performed by the Licensee or by another person having a right to use a copy of a program, or on their behalf by
a person authorised to do so;
(b) the information necessary to achieve interoperability has not previously been readily available to the persons referred to in
point (a);
(c) those acts are confined to the parts of the original program which are necessary in order to achieve interoperability.
8. The provisions of preceding paragraph 7 shall not permit the information obtained through its application:
(a) to be used for goals other than to achieve the interoperability of the independently created computer program;
(b) to be given to others, except when necessary for the interoperability of the independently created computer program;
(c) to be used for the development, production or marketing of a computer program substantially similar in its expression, or for
any other act which infringes copyright.
9. In accordance with the provisions of the Berne Convention for the protection of Literary and Artistic Works, enacted in Italy
with the Italian law 20th of June 1978, n. 399 as amended and supplemented, the provisions of article 64 quater Law 22nd of April
1941, n. 633 as amended and supplemented and art. 6 of Directive 2009/24/EC of the European Parliament and of the Council of
23rd April 2009 as amended and supplemented may not be interpreted in such a way as to allow its application to be used in a
manner which unreasonably prejudices the right-holder's legitimate interests or conflicts with a normal exploitation of the
computer program.
Art. 6 Property Transfer prohibition
1. The software provided by NextFEM SRLS and the included documentation remain exclusive property of NextFEM SRLS. The
Customer is explicitly forbidden to distribute products of NextFEM SRLS or copies to anyone or to sell them or assign them in
license to third parts or to lease them, or in any case to allow others to use the programs, either in exchange for payment or not.
In these cases, NextFEM SRLS can revoke the user's license of the free program or of any of the paid modules at any time.
2. This clause will remain in force even after the rescission or the termination to any title of this contract.
Art. 7 Right holders Secret Modifications
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1. The software provided by NextFEM SRLS, the included documentation, the program code, its layout, the structures and the
program files organization, the program name, the Company logo and any other representation form within the software are
subjected to copyright; this one, and any rights coming from it or in any way connected to the copyright are property of
NextFEM SRLS. Other trademarks belong to the respective owners.
2. The Customer is required to keep secret the content of the software provided by NextFEM SRLS and the included
no
modifications to the software provided by NextFEM SRLS or to incorporate it entirely or in part in other software without
preventive written authorisation by NextFEM SRLS, without prejudice to current mandatory legislation on the matter. In these
cases, NextFEM SRLS can revoke the user's license of the free program or of any of the paid module at any time.
3. This clause will remain in force even after the termination or the expiration in whatever manner of this agreement.
Art. 8 Fee Solve et repete
es, improvements or
changes. Different conditions may apply to paid software and for Education licenses.
2. To ensure the continuity of the license and of paid modules, the Customer must pay the relative fee at least 15 days before the
current license exp
may be blocked. For no reason the payment of the annual fee regarding the software and/or its single component module
and/or required services can be delayed or suspended; eventual exceptions or Customer's disputes will be managed and solved
separately.
3. NextFEM SRLS provides software updates for 12 (twelve) months starting from the delivery date, limited to the functionalities
of paid module/s. During this period, encountered malfunctions in paid modules will be fixed to ensure the correct functionality.
This guarantee does not apply to functionalities not included in the paid modules.
Art. 9 Warranty and liability
1. For both the basic so
provide maintenance, support, updates, improvements or changes. During the validity of this agreement, eventual software
updates or patches may be released.
2. NextFEM SRLS is committed, only for functionalities of the paid modules, and for 12 months from the purchase, to keep the
software able to perform the tasks described in the user manual. During this period, encountered malfunctions of the paid
modules will be fixed to ensure the correct functionality. This guarantee does not apply to functionalities not included in paid
modules, nor to Educational licenses, as stated in art. 14 of this agreement.
3. The warranty is conditioned to the correct ori
existence of the minimum requirements prescribed for the correct software installation, as well to the circumstances in which the
Customer installs the updates and patches that can be made available by the Licensor via an independent download made from
the nextfem.it website, and also to the correct use of the system and software by the Customer.
4. The Customer is the sole responsible for the choice of the software produced by NextFEM SRLS and its compliance to his own
needs and purpose of use, for any input fed to the software and any output coming from the program or from its parts, and must
verify results, reports and the checks conducted with it.
5. The software provided by NextFEM SRLS are a representation of the current state of development, so NextFEM SRLS cannot
grant that they will always work correctly in every applications and in any situation.
6. Customer is responsible of installation, launch, and usage of the software produced by NextFEM SRLS and of the application of
the related updates and patches, their transfer to the computer, the settings, and everything not explicitly stated in this Contract
that burden on NextFEM SRLS.
7. This warranty is not valid whenever a software fault is due to accident, improper and/or non-conforming and/or wrongful
usage. Any change to the software made directly by the Customer will result in the withdrawal of this warranty.
8. NextFEM SRLS does not take any responsibility and is not liable for any direct and/or indirect, special, collateral, incidental
and/or consequential damage, including lost profits, incurred by the Customer or third parts caused through the use or lack of
use of the software and by any means related and/or consequential to eventual software quality, adequacy, use and usability
flaws, which are therefore to be exclusively borne by the Customer, except as what is compulsorily required by law.
9. NextFEM SRLS does not take any responsibility and is not liable for any direct and/or indirect, special, collateral, incidental
and/or consequential damage, including lost profits, incurred by the Customer or third parts caused through the use or lack of
use of the software and by any means related and/or consequential to eventual software quality, adequacy, use and usability,
caused by suppliers or by parts of program developed by third parts. To these parts of programs developed by third parts are
applied their own licensing conditions, which can be found inside NextFEM SRLS software from
.
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Art. 10 Software restitution - Software deletion
1. Within one month from the termination of this agreement for any reason, the Customer must delete and eliminate any copy of
the software he owns, even if they are backup copies. The Customer must confirm this by sending to NextFEM SRLS an e-mail
within the same deadline.
2. As a consequence of the termination of this agreement as in the previous subparagraph, the license of use is revoked and
cannot be use anymore by the Customer for any purpose.
Art. 11 Support and/or consultation 1. Upon Customer's request, NextFEM SRLS is willing to give, by a preventive stipulation of specific separate contracts, the
necessary support and/or consultation to maintain or launch or update or personalize or implement the software provided by
NextFEM SRLS, also for a potential training of Customer's staff who is appointed for its use.
2. The possible existence of other contractual relationships between NextFEM SRLS and the Customer does not affect other
connections between them, that will remain separated and independent.
3. The free licenses of use granted by NextFEM SRLS (i.e. basic program, Educational license, etc.) are not covered by any kind of
support.
4. The paid licenses of use granted by NextFEM SRLS to the Customer can be issued with a first-installation assistance via email,
until 7 days after the payment. Further paid support can be supplied for one year starting from the license acquisition. Support
period can be bought or renewed only together with the program license or renewal, respectively. Assistance is supplied only via
email and concerns the sole software use or program functioning. NextFEM SRLS does not supply support on the engineering
choices made or to be made for designing any structures. Any advice given by support cannot substitute the engineering
judgement of the Customer, who is the sole responsible of the structure designed, analysed and checked with the program,
including the obtained results.
Art. 12 Communication 1. Any communication from one part to another of this agreement must be sent as a registered letter with signed return receipt
or as a handcertified e-mail to nextfem@pec.nextfem.it.
Art. 13 Litigation Applied law 1. This contract is subjected to the Italian law.
2. Any litigation in any case connected to this agreement shall be exclusively of the competence of the Court of Treviso.
Art. 14 Educational license
1. Educational licenses are distributed for a predetermined number of PCs prior oral or written agreement with NextFEM SRLS.
NextFEM SRLS solely decides the number of distributed licenses prior consultation with the Customer.
2. Educational licenses can be given freely to a private or public Customer, when it is a training institution, a research and
development company or a school, at the incontestable discretion of NextFEM SRLS. In such case, the given Educational licenses
do not grant to the Customer the right to use them after the planned time period conceded to the Licensee, and they can be
revoked at any time by NextFEM SRLS without any justification or notice to the Customer.
3. When given freely, Educational license does not allow for any refund of the cost of the software, for any reason.
4. When given freely, Educational license does not allow for any kind of support supplied by NextFEM SRLS, neither for
malfunctioning of the program. Hence, the warranties described in art. 9, paragraph 2 of this agreement are excluded.
Art. 15 Changes of terms in this agreement
RLS
by email to be sent to the Licensee to the address given during registration on nextfem.it website. The Licensee has the right of
withdrawal by sending a registered letter with signed return receipt or as a hand-delivered registered letter addresses to
-mail to nextfem@pec.nextfem.it compulsorily
within 14 days from the receipt of the communication related to the changes of the agreement terms.
Art. 16 Final provisions -
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1. Whenever one of the clauses contained in this Contract will be declared invalid or without effects, entirely or in part, this will
not invalidate the other clauses, except when the Licensor considers in bona fide the clause as essential, and consequently shall
ask for the resolution of the contract.
2. For anything not expressively provided in this contract, the Italian Civil Code rules shall be applied and the Legislative Decree
of 29th of December 1992, n. 518 as amended and supplemented, regarding the implementation of the Council Directive n.
91/250 CEE of 14th of May 1991 on the legal protection of computer programs which modifies and integrates Law 22nd of April
1941, n. 633, and this last law as amended and supplemented, and the Directive 2009/24/EC of the European Parliament and the
Council of 23rd of April 2009 as amended and supplemented.
Oderzo (TV), (date of acceptance of this contractual conditions)
NextFEM SRLS

Licensee

Pursuant to and in accordance with art. 1341 and 1342 c.c., the Customer specifically approves, for having them read,
understood and known, the articles: 2 (Duration Agreement termination) paragraph 2, 3 (License delivery) paragraph 3, 4
(Installation) paragraph 3, 5 (Programs usage), 6 (Property Transfer prohibition), 7 (Right holders Secret Modifications)
paragraph 2, 8 (Fee Solve et repete) paragraph 2, 9 (Warranty and liability) paragraphs 3,4,5,6,7,8,9, 10 (Software restitution Software deletion) paragraph 4, 11 (Support and/or consultation), 13 (Litigation
Applied law), 14 (Educational license)
paragraphs 2 and 3, 15 (Changes of terms in this agreement), 16 (Final provisions).
Oderzo (TV), (date of acceptance of this contractual conditions)
The Customer
This software is copyright of NextFEM, 2014-2019.
Windows® is a registered trademark of Microsoft Corporation. Other trademarks belong to their respective owners.

NextFEM Designer uses:
OOFEM v2.4
ZedGraph Library v.5.1.5.31366
Clipper Library v.6.1.3
net Dxf Library v.0.9.1
Poly2Tri Library
RichTextBoxLinks Library
SlimDX Library
Jace Library
UnitConversionLib Library
DotNetZip Library v1.13.7
Triangle.NET Library Beta 4
Netgen Mesh Generator Library v.6.0
PDFSharp v.1.32
RTF Document Constructor Library
log4net Library v.1.2.15
SharpZipLib Library v.0.86.0
Esent Managed Interface v.1.9.4
xBIM Essentials v.5
xBIM Geometry v.5
XbimWebUI for xBIM toolkit
Desktop Bridge Helpers v.1.1.0
DocX Library v.1.1.0
Splicer Library v.1.0
DirectShowLib v.2.1
OpenStreetMap site
IDEA StatiCa IOM
Newtonsoft Json.NET v12.0
All the licenses, including the general one for the program and for paid modules, can be found in the dialog ?/About
.
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